Printer Basics
Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of SEIKO EPSON CORPORATION. The information contained herein is designed only for use with this EPSON printer. EPSON is not responsible for any use of this information as applied to other printers.

Neither SEIKO EPSON CORPORATION nor its affiliates shall be liable to the purchaser of this product or third parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of: accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this product, or (excluding the U.S.) failure to strictly comply with SEIKO EPSON CORPORATION’s operating and maintenance instructions.

SEIKO EPSON CORPORATION shall not be liable for any damages or problems arising from the use of any options or any consumable products other than those designated as Original EPSON Products or EPSON Approved Products by SEIKO EPSON CORPORATION.

A Note Concerning the Responsible Use of Copyrighted Materials

Digital cameras and scanners, like photocopiers, conventional cameras, and ink jet printers, can be misused by improper copying and reprinting of copyrighted material. While some countries’ laws permit limited copying of copyrighted material in certain circumstances, those circumstances may not be as broad as some people assume. EPSON encourages each user to be responsible and respectful of the copyright laws when using digital cameras, scanners, and ink jet printers.

Trademarks

EPSON, EPSON Stylus, EPSON Photo Stickers, and MicroWeave are registered trademarks and PRINT Image Matching and the PRINT Image Matching logo are trademarks of SEIKO EPSON CORPORATION.

EPSON Print Lab, EPSON Photo Center, EPSON Store, SoundAdvice, and EPSON Connection are service marks, and Direct Connect Compatible (DCC), Resolution Performance Management, EPSON Software, ColorLife, PhotoEnhance, and BorderFree are trademarks of Epson America, Inc.

General Notice: Other product names used herein are for identification purposes only and may be trademarks of their respective owners. EPSON disclaims any and all rights in those marks.

The ENERGY STAR emblem does not represent EPA endorsement of any product or service.

Printed on recycled paper
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Welcome!</td>
<td>1</td>
</tr>
<tr>
<td>PRINT Image Matching and Exif Print</td>
<td>2</td>
</tr>
<tr>
<td>About PRINT Image Matching</td>
<td>2</td>
</tr>
<tr>
<td>About Exif Print</td>
<td>2</td>
</tr>
<tr>
<td>About Your Software</td>
<td>3</td>
</tr>
<tr>
<td>About Your Documentation</td>
<td>4</td>
</tr>
<tr>
<td>Warnings, Cautions, Notes, and Tips</td>
<td>4</td>
</tr>
<tr>
<td>Viewing Your On-Screen Reference Guide</td>
<td>5</td>
</tr>
<tr>
<td>Using EPSON Paper</td>
<td>7</td>
</tr>
<tr>
<td>Choosing the Paper for Your Project</td>
<td>8</td>
</tr>
<tr>
<td>Available Papers</td>
<td>9</td>
</tr>
<tr>
<td>Loading Paper in the Sheet Feeder</td>
<td>11</td>
</tr>
<tr>
<td>Loading Envelopes</td>
<td>12</td>
</tr>
<tr>
<td>Loading and Using Roll Paper</td>
<td>13</td>
</tr>
<tr>
<td>Selecting Roll Paper Cutting Options</td>
<td>15</td>
</tr>
<tr>
<td>Removing Roll Paper From the Printer</td>
<td>15</td>
</tr>
<tr>
<td>Storing Your Photos</td>
<td>16</td>
</tr>
<tr>
<td>Printing Without a Computer</td>
<td>17</td>
</tr>
<tr>
<td>Using Your Camera’s Print Settings</td>
<td>18</td>
</tr>
<tr>
<td>Using PRINT Image Matching</td>
<td>18</td>
</tr>
<tr>
<td>Using DPOF</td>
<td>18</td>
</tr>
<tr>
<td>Getting Photos into the Printer</td>
<td>19</td>
</tr>
<tr>
<td>Inserting a Memory Card</td>
<td>19</td>
</tr>
<tr>
<td>Removing a Memory Card</td>
<td>20</td>
</tr>
<tr>
<td>Connecting a Digital Camera or External Storage Device</td>
<td>21</td>
</tr>
</tbody>
</table>
Selecting Photos for Printing
  Printing an Index 23
  Selecting One Photo 24
  Selecting a Set of Photos 25
  Using DPOF to Select Your Photos 26
Printing Your Selected Photos 27
  Selecting the Correct Paper Type 29
  Planning the Size of Your Photos 30
  One-Touch Printing 32
Touching Up Your Photos 33
  Automatically Adjusting Your Photos 33
  Manually Adjusting Your Photos 34
Cropping and Sizing Your Photos 35
Adding Crop Marks and Photo Information 37
  Printing Crop Marks 37
  Adding Photo Information 37
Printing Special Layouts 38
  Printing Stickers 38
  Printing Greeting Cards 41
  Printing with Iron-On Transfer Paper 42
Saving Your Image Files 43

Printing From Your Computer 45
Copying Photos to Your Computer 46
  Configuring PhotoStarter 47
  Removing a Memory Card 48
Basic Printing in Windows 49
  Selecting the Settings You Use Most Often 53
Basic Printing on a Macintosh 53
  Printing with OS 8.6 to 9.x 54
  Printing in OS X 56
Printing Borderless Photos
  Windows 61
  Macintosh OS 8.6 to 9.x 62
  Macintosh OS X 62
Printing on Roll Paper
  Windows and Macintosh OS 8.6 to 9.x 63
  Macintosh OS X 65
  Removing Roll Paper From the Printer 67
Customizing Your Print Settings
  Customizing Windows Print Settings 68
  Customizing Macintosh Print Settings 70
Selecting the Correct Media Type 72
Using PRINT Image Matching 73
  Using Film Factory 73
  Using the P.I.M. II Plug-in for Adobe Photoshop 77

Maintaining Your Printer 83
Cleaning the Print Head 84
  Running the Head Cleaning Utility 84
  Examining the Nozzle Check Pattern 85
Replacing an Ink Cartridge 85
  Removing and Installing Ink Cartridges 86
Aligning the Print Head 89
Aligning the Cutter 90
Cleaning the Printer 91
Transporting the Printer 92

Problem Solving 93
Diagnosing Problems 94
Solving Problems Setting Up the Printer or Installing Software 94
Solving Printer Problems 95
Solving Print Quality Problems 97
Solving Problems with Paper Feeding 100
Solving Miscellaneous Printout Problems 101
Running a Printer Check 103
Uninstalling and Reinstalling Printer Software 104
  Windows 104
  Macintosh OS 8.6 to 9x 105
  Macintosh OS X 10.x 105
Where To Get Help 106

Installing Your Printer Software 109
Installing Printer Software on Windows Me 110
  Installing the Printer Driver and Utilities for Windows Me 110
  Installing Additional Software for Windows Me 111
Installing Printer Software on Windows 2000 113
  Installing the Printer Driver and Utilities for Windows 2000 113
  Installing Additional Software for Windows 2000 115

Notices 117
Windows System Requirements 117
Macintosh System Requirements 117
Important Safety Instructions 118
  Ink Cartridge Safety Instructions 119
Energy Star Compliance 120
FCC Compliance Statement 120
Declaration of Conformity 121
Epson America, Inc., Limited Warranty 122

Index 125
Welcome!

Your EPSON Stylus® Photo 925 is an amazing printer for digital photography. You can print pictures directly from your digital camera’s memory card. Choose from various layouts, adjust image brightness, and crop your photos without even turning on your computer!

Create true BorderFree™ photos directly from your printer in a variety of sizes perfect for albums or framing. You get quick and easy snapshots and enlargements just minutes after taking pictures with your digital camera.

If you want to save your picture files, you can transfer them immediately to your Windows® or Macintosh® computer and print from there.

Here are some of the printer’s outstanding features:

■ EPSON’s exclusive 6-color ink technology lets you achieve fine shadow detail, dazzling highlights, and excellent fill across a wide range of colors. Black ink, instead of composite black, is used for printing all types of pictures, resulting in rich-looking color photos. Genuine EPSON® ink and papers create long-lasting and water-resistant prints.

■ Ground-breaking Resolution Performance Management™ (RPM) technology optimizes the number and placement of ink droplets on a variety of papers for superior photo quality and performance, with manageable print file sizes.

■ Three built-in memory card slots support CompactFlash™ Type I and II, SmartMedia™, Sony Memory Stick®, and IBM® Microdrive™ (Secure Digital and MultiMediaCard are supported with an optional adapter.)

■ The USB port lets you connect a digital camera (supported models) or external storage device, such as an Iomega® Zip® drive, directly to the printer so you can access and store images without a computer.

■ An optional preview monitor (EPSON part number C12C860005) is available to help you select photos for printing. See page 107 for ordering information.
PRINT Image Matching and Exif Print

Your EPSON Stylus Photo 925 printer supports these innovative digital image formats to give you the best photo prints possible:

■ PRINT Image Matching™ (both P.I.M. and P.I.M II)
■ Exif Print

About PRINT Image Matching

EPSON’s revolutionary PRINT Image Matching technology lets your digital camera and printer work together automatically to produce the best prints possible. Digital camera manufacturers that support PRINT Image Matching include EPSON, Casio®, JVC®, Konica®, Kyocera®, Minolta®, Nikon®, Olympus®, Panasonic®, Pentax®, Ricoh®, Sanyo®, and Toshiba®. Check with your camera’s manufacturer or visit www.printimagematching.com to find out if PRINT Image Matching technology is included with your camera.

With PRINT Image Matching, the digital camera manufacturer can set specific printing options for each camera model. These options include:

■ Contrast, sharpness, and brightness
■ Gamma level, color space, color saturation, and noise reduction
■ Shadow point, highlight point, and color balance

The camera saves this information in each JPEG image file (and TIFF files from P.I.M. II-enabled cameras). Your printer—along with P.I.M.-enabled software, such as EPSON Software™ Film Factory™, the P.I.M. II Plug-in for Adobe® Photoshop®, or ArcSoft™ PhotImpression™ (all included with your printer)—uses the information to ensure the most accurate image reproduction.

But don’t worry if your camera doesn’t include PRINT Image Matching technology—your EPSON Stylus Photo 925 gives great photo printing results.

About Exif Print

The Exif (Exchangeable Image File) Print format includes information about your digital camera settings in JPEG files so your printer and application can use them to create accurate print settings. Most digital cameras store Exif Print information such as shutter speed, metering, flash, exposure settings, resolution, and lens use in the JPEG image file. Your printer—along with EPSON Software Film Factory or P.I.M. II Plug-in—uses the information to ensure the most accurate image reproduction.
About Your Software

The printer software CD-ROM that came with your printer includes all the software you need for printing. See the Start Here sheet for installation instructions.

■ Your printer driver runs your printer and lets you control how your documents look. You can’t print from your computer without it.

Tip: It’s a good idea to check EPSON’s support web site periodically for free updates to your printer driver. Visit http://support.epson.com. Download instructions are posted for your convenience.

■ Your photo software includes these great tools:

EPSON Software Film Factory is a photo management program that lets you organize, beautify, and print your photos in a flash. Supports PRINT Image Matching (both P.I.M. and P.I.M. II) and Exif Print (except with Mac® OS X).

EPSON PhotoStarter and CardMonitor utilities help your system handle photos on a memory card (not needed on Windows XP systems). If you want, you can have your photos copied to your computer automatically—and even open one of your photo editing programs—whenever you insert a memory card in your printer. (These programs are installed automatically with your printer driver.)

ArcSoft PhotoImpression is an easy-to-use photo editing program that lets you edit, enhance, retouch, or add special effects to any image with just a few clicks. Supports PRINT Image Matching (P.I.M. and P.I.M. II) and Exif Print (except with Mac OS X).

P.I.M. II Plug-in for Adobe Photoshop lets you retain PRINT Image Matching and Exif Print image quality when you import JPEG or TIFF files from your P.I.M.-, P.I.M. II-, or Exif Print-enabled digital camera. (Compatible with Photoshop 6.0 and 7.0, and Photoshop Elements 1.0 and 2.0.)

■ Your on-screen Reference Guide (printer manual) gives you additional details about your printer. You need a browser—such as Microsoft® Internet Explorer version 4.0 or later or Netscape® Navigator® version 3.0 or later—to view the guide. See page 5 for details.

■ EPSON PhotoCenter™ is EPSON’s free photo-sharing web site where you can store, organize, and share your photos; print high-resolution photos straight from the web; and create free online postcards with your photos. Your printer software installer lets you add a link to the EPSON PhotoCenter on your desktop.
About Your Documentation

To set up your printer and install its software, see the Start Here sheet. For tips on printing without a computer, see the Quick Reference booklet. This book contains system requirements, important safety information, your warranty, and instructions on:

- Viewing your on-screen Reference Guide
- Printing all types of photos without a computer
- Printing with Windows or on a Macintosh
- Maintaining the printer
- Solving basic problems

For more details about printing with, maintaining, or troubleshooting your printer, see your on-screen Reference Guide, as described on page 5.

Warnings, Cautions, Notes, and Tips

Please follow these guidelines:

Warnings must be followed carefully to avoid bodily injury.
Cautions must be observed to avoid damage to your equipment.
Notes contain important information about your printer.
Tips contain additional hints for better printing.
Viewing Your On-Screen Reference Guide

Your printer CD-ROM includes an on-screen Reference Guide (printer manual). You need a browser—such as Microsoft Internet Explorer 4.0 or later or Netscape Navigator 3.0 or later—to view it. If you are using a different browser, the pages may not display correctly. (A browser is not included on the printer software CD-ROM.)

If you didn't install the Reference Guide when you first set up your printer, you can install it by following these steps:

1. Insert your printer software CD-ROM.
2. **Windows**: Wait for the CD-ROM to open.
   - **Macintosh**: Double-click the EPSON icon on your desktop, if necessary, then double-click the EPSON icon in the CD-ROM window.

   The Main Menu appears:

3. Click **Install Printer Manual** to install the guide.

Once it's installed, you can view the Reference Guide by doing one of the following:

- **Windows**: Double-click the **Printer Manual** icon on your desktop. You can also click **Start**, **Programs** (or **All Programs** in Windows XP), **EPSON**, **Online Reference Guide**, then click **Printer Manual**.
- **Macintosh**: Double-click the **Online Guide** icon on your desktop.
When you first open the Reference Guide, you see this screen:

Click a topic on the left to expand the table of contents. After expanding the table of contents, you can click on the topic you want to view.

- If there's a right arrow ➤, click it to view subtopics, then click on a topic to go to it.
- Click the down arrow ▼ to close a subtopic list.

If you see an icon for a graphic when viewing your Reference Guide in Netscape Navigator, click the Reload button to load the graphic.
Using EPSON Paper

EPSON offers a wide variety of papers that let you customize your projects and achieve professional results. This chapter gives you guidelines on:

- “Choosing the Paper for Your Project” on page 8
- “Loading Paper in the Sheet Feeder” on page 11
- “Loading Envelopes” on page 12
- “Loading and Using Roll Paper” on page 13
- “Storing Your Photos” on page 16
Choosing the Paper for Your Project

Once you know which photos you want to print, you need to select the type of paper to print them on, the paper size, and your layout. Here are some helpful tips:

■ Select a type of paper to suit your image.
   A photograph is meant to last for years. For best quality, use one of the special EPSON papers listed on page 9.

■ Use the paper designed for your printer.
   EPSON paper is designed to work with EPSON ink and printers. If you use incompatible paper, you may not get the results you expect.

■ Select a paper size and layout to get the size of photos you want.
   When using the printer in stand-alone mode (without connecting it to a computer), it automatically resizes your photos to fit the layout you choose on any size paper—from letter-size to 4 × 6. To get the size of photos you want, see the table on page 30; it will help you choose the right combination of paper size and layout.

Note: You can print borderless photos only on certain sizes of paper:
4 × 6 inches, 5 × 7 inches, 8 × 10 inches, and letter-size individual sheets; and 4-inch and 8.3-inch wide roll paper. (8.3-inch wide roll paper can be used only when printing from your computer.)
**Available Papers**

Depending on whether you’re printing in stand-alone mode (using the printer’s control panel) or from an application running on your computer, you can choose from different available papers:

- When printing without a computer, you can use plain paper or special EPSON papers as listed below, including 4-inch wide roll paper.

- When printing from your computer, you can use plain paper or any of the paper types listed on the inside back cover, including both 4-inch and 8.3-inch wide roll paper.

**Tip:** For digital photos that look and feel like traditional photos, choose one of the EPSON Premium Photo papers.

<table>
<thead>
<tr>
<th>Paper name and description</th>
<th>Letter size</th>
<th>4 x 6</th>
<th>5 x 7</th>
<th>8 x 10</th>
<th>4 in. roll</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glossy Photo Paper:</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>For snapshots, reprints,</td>
<td>S041411</td>
<td>S041458</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>and enlargements</td>
<td>(20 sheets)</td>
<td>(20 sheets)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>S041649</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(20 sheets)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>— —</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td>— —</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
</tbody>
</table>

| Premium Glossy Photo Paper: | S041286     | S041682 | S041464 | S041465 | S041302   |
| Ideal for high gloss      | (20 sheets) | (20 sheets) | (20 sheets) | (20 sheets) | (approx. 52 4 x 6 prints) |
| photos to be framed,      | S041667     |       |       |        |           |
| enlarged, or kept in      | (50 sheets) |       |       |        |           |
| albums                   | — —         | —     | —     | —      | —         |

| Premium Semigloss Photo Paper: | S041331     | —     | —     | —      | S041329   |
| Semigloss photos for      | (20 sheets) | —     | —     | —      | (approx. 52 4 x 6 prints) |
| framing and albums        | — —         | —     | —     | —      | —         |

| Premium Luster Photo Paper: | S041405     | —     | —     | —      | —         |
| Perfect for portraits     | (20 sheets) | —     | —     | —      | —         |
| with a textured surface   |             | —     | —     | —      | —         |

| Matte Paper Heavyweight:  | S041257     | —     | —     | S041467 | —         |
| Highest-quality matte     | (50 sheets) | —     | —     | (50 sheets) | —     |
| photos                    |             | —     | —     | —      | —         |

<p>| ColorLife™ Photo Paper:    | S041500     | —     | —     | —      | —         |
| Fade-resistant photos with a smooth satin finish | (20 sheets) | —     | —     | —      | —         |</p>
<table>
<thead>
<tr>
<th>Paper name and description</th>
<th>Letter size</th>
<th>4 x 6</th>
<th>5 x 7</th>
<th>8 x 10</th>
<th>4 in. roll</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Photo Stickers.®</td>
<td>—</td>
<td>S04144</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>fun photos with or without colorful frames</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Iron-On Transfer Paper:</td>
<td>S041153</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Transfer photos onto fabric</td>
<td>S041155</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S041155 (10 sheets)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>S041155 (50 sheets)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Glossy Photo Greeting Cards:</td>
<td>S041606</td>
<td>—</td>
<td>—</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Personalize cards with your own photos (4.75 × 7 inches, folded; includes envelopes)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** These papers are designed to give you professional-quality photos directly from your printer. Many more paper types and sizes are available when you print from your computer, as listed on the inside back cover.

To order EPSON paper, contact your dealer or call the EPSON Store℠ at (800) 873-7766 or visit our web site at www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.
Loading Paper in the Sheet Feeder

To load paper in the sheet feeder, follow these steps:

1. Make sure the paper support is attached.

2. Place your paper against the right edge of the feeder. Make sure the printable (whiter or glossier) side of the paper is face up. If you are loading multiple sheets, fan the stack of paper before loading it to prevent paper jams.

Note: Don’t load paper above the arrow mark inside the left edge guide. Some special papers can be loaded only one sheet at a time. See your online Reference Guide for details.

3. Slide the left edge guide against the paper.

4. Open the output tray and extend it.

You should also follow these guidelines:

■ Always load the short edge first, even when you’re printing landscape-oriented pictures.

■ When using special papers, check the paper package for additional instructions. Some papers require using a support sheet included in the package.

Note: Always keep unused paper in the original package and store it flat to prevent curling.
Loading Envelopes

You can load up to 10 envelopes at a time:

1. Place the envelopes against the right edge of the sheet feeder. Load them with the printable side facing you, flap-edge to the left. Then slide the left edge guide against the envelopes.

   **Tip:** For best results, press each envelope flat before loading it, or load one envelope at a time.

2. Set the thickness lever on the right side of the printer to the position for envelopes, as shown. (Remember to return the thickness lever to the position for sheet paper when you're done printing on the envelopes.)

3. Before you print, make sure you select these settings in your printer software:
   - For the Media Type, select **Plain Paper**
   - For the Paper Size, select the size of your envelopes
   - For the Orientation, select **Landscape** (in Macintosh OS X, click the icon)

See page 49 (Windows), page 54 (Macintosh OS 8.6 to 9.x), or page 56 (OS X) for more information.
Loading and Using Roll Paper

The printer accepts roll paper in widths of 4 inches and 8.3 inches; however, when printing in stand-alone mode (without connecting the printer to a computer), the printer’s built-in layouts work only with 4-inch roll paper. This paper size is ideal for printing snapshots and panoramics.

**Tip**: It’s a good idea to check your ink levels before you print on roll paper. See page 85 for instructions. Replacing cartridges while roll paper is loaded can smear the paper.

Follow these instructions to load roll paper:

1. If you’re loading a new paper roll, remove the protective paper from the end of the roll.
2. Insert both holders into the roll.
   
   Make sure the edge of the paper is cut straight across. A diagonal cut may cause paper feed problems. If necessary, trim the paper.
3. To avoid paper feeding problems, uncurl the end of the paper.
   
   Use a folded sheet of paper. Roll the paper backwards inside the sheet, as shown.
4. Remove the paper support and extend the output tray. Make sure the printer is turned on.
5. Insert the tabs on the roll paper holders into the slots in the back of the printer as shown.

6. Feed the end of the paper into the printer as far as it will go, then slide the left edge guide against the paper.

7. Hold the paper in place while you press the roll paper button. The paper feeds into the printer.

**Caution:** Make sure your hands are clean or wear gloves to avoid marring the paper.
Selecting Roll Paper Cutting Options

You can have the printer cut each page automatically, or you can cut the paper yourself by pressing the roll paper button after printing one or more print jobs. Follow the instructions in one of these sections:

- If you’re printing from your computer, see “Printing on Roll Paper” on page 63.
- If you’re using your printer without a computer, follow the instructions below.

**Note:** If the printer doesn’t cut the roll paper at the correct position between your photos, you can adjust it for a more exact cut. See “Aligning the Cutter” on page 90.

1. Enter the Advanced Settings menu on the printer’s control panel.
2. Highlight Roll Paper Cut, then press Select.
3. Highlight one of the following options, then press Select to activate it:
   - **None** if you want to cut the paper yourself after printing one or more print jobs
   - **Save Paper cut** to have each page cut automatically; less exact in some cases than using Normal cut
   - **Normal cut** to cut each page automatically; cuts off a small strip of paper between each page (if you print more than one page in a single print job), but provides the most exact cut when printing borderless photos

These settings are saved until you change them—even if you turn off the printer, choose a different layout, or select a new set of photos for printing.

**Note:** If you’ve set up the printer to cut your photos automatically, you should select High or Super High as your print quality for best results (see page 28).

Removing Roll Paper From the Printer

When your last print job is done printing, press the roll paper button to cut and eject the last page.

If you want to continue printing, you don’t have to do anything special. Just select your photo and layout options as usual, and begin printing. The roll paper is positioned automatically for your next print job.
If you’re finished printing on roll paper, here’s how to remove it:

1. Press the roll paper button and hold it down for about three seconds. The paper feeds all the way back and an error message appears on the display.

2. Use the knobs on the roll paper holders to rewind the paper. (Make sure you pull the paper out fully from the feed slot.)

3. Press the roll paper button to clear the error message.

**Note:** Always keep unused paper in the original package.

---

**Storing Your Photos**

With proper care, photographs from your EPSON Stylus Photo 925 printer will last for many years. The special EPSON inks designed for your printer are formulated to achieve improved lightfastness when used with EPSON papers for prints that are properly displayed or stored.

As with traditional photos, proper care will minimize color changes and lengthen display life:

- For display, EPSON recommends that prints be framed under glass or a protective plastic sleeve to protect them from atmospheric contaminants like humidity, cigarette smoke, and high levels of ozone.

- As with all photographs, keep your prints away from high temperatures and humidity and out of direct sunlight.

- For proper storage, EPSON recommends that you keep prints in a photo album or plastic photo storage box in acid-free, archival sleeves commonly available from most camera stores.

- Be sure to follow any other storage and display instructions included in the paper package.
Printing Without a Computer

Your EPSON Stylus Photo 925 lets you print photos quickly and easily without a computer. Just insert your digital camera’s memory card, choose settings from the control panel, and press the green Print button.

Before you start, make sure you plug in the printer, turn it on, and install ink cartridges, as described on your Start Here sheet. Then follow the instructions in these sections:

- “Using Your Camera’s Print Settings” on page 18
- “Getting Photos into the Printer” on page 19
- “Selecting Photos for Printing” on page 23
- “Printing Your Selected Photos” on page 27
- “Touching Up Your Photos” on page 33
- “Cropping and Sizing Your Photos” on page 35
- “Adding Crop Marks and Photo Information” on page 37
- “Printing Special Layouts” on page 38
- “Saving Your Image Files” on page 43
Using Your Camera’s Print Settings

Your EPSON Stylus Photo 925 is designed to work hand-in-hand with the latest advances in digital cameras. With PRINT Image Matching, you can get beautiful print results from all your digital photos, easily and automatically. And with DPOF, you can use your camera to select which photos you want to print—before you even get home to your printer.

Using PRINT Image Matching

If your digital camera supports PRINT Image Matching (P.I.M. or P.I.M. II), you can use this technology whenever you print.

With PRINT Image Matching, special print instructions are automatically saved in your photo files. For example, macro mode pictures might include commands for sharpness and clarity, while portrait mode pictures might emphasize soft focusing and subtle flesh tones.

When you connect your camera to the printer or insert its memory card, all the PRINT Image Matching commands are read and applied; this ensures the most faithful possible reproduction of the images taken by your camera. A special icon is displayed on the control panel to remind you that your photos contain PRINT Image Matching data.

If you don’t want to use PRINT Image Matching, you can turn it off as described on page 33. You can also use PRINT Image Matching when printing from your computer; see page 73.

Using DPOF

Digital Print Order Format (DPOF) is a feature of many digital cameras that lets you select images and determine how many copies of each image you want to print right from the control panel. When you connect your camera to the printer or insert its memory card, DPOF displays as the Print Mode; your photos and the number of copies you want to print are automatically selected; all you have to do is choose your paper type and size, then print.

For details on using DPOF, see page 26.
Getting Photos into the Printer

**Note:** Make sure your printer is set up, plugged in, and turned on, as described on the *Start Here* sheet.

Your EPSON Stylus Photo 925 can print photos stored:

- On a memory card (see below)
  
  Many digital cameras store pictures on a removable memory card. Before you can print, you need to take the memory card out of your camera and insert it into the printer.

- In a digital camera (see page 21)
  
  Some digital cameras store pictures in the camera’s internal memory, instead of on a card. To print your photos, you have to connect the camera to the printer using your camera’s USB cable.

- On a data storage device (see page 21)
  
  Using a USB cable, you can connect an Iomega Zip drive and certain other external data storage devices to the printer.

However your photos are stored, make sure the image files meet these requirements:

- JPEG files only
- The file storage device should comply with DCF (Design rule for Camera File systems) Version 1.0
- Resolutions ranging from 160 × 160 to 4200 × 4200 pixels
- No more than 999 images (although you may have additional images on your card or storage device, the printer can read only the first 999)

### Inserting a Memory Card

Your printer works with several types of memory cards, as shown below. (If you have a Secure Digital or MultiMediaCard, you can connect it to the printer using a special USB adapter as described on page 21.)
Follow these guidelines to insert your memory card:

1. Make sure the printer is turned on, then insert the memory card into the appropriate slot, as shown:

   ![Memory Card Slots](image)

   - **CompactFlash or Microdrive** (bottom)
   - **Memory Stick** (middle)
   - **SmartMedia** (top)

   If you're using a CompactFlash or Microdrive card, insert it all the way in. If you're using a Memory Stick or SmartMedia card, it won't be possible to insert it fully; this is normal.

2. After a moment, the printer reads and counts the number of images on your card. When it's done, you see a screen similar to this on the printer's control panel and your images are available for printing.

   ![Printer Control Panel](image)

   **Note:** Insert just one card at a time, so you know which card the printer is reading.

   **Caution:** Do not eject a card while the light next to the card slot is flashing, or you may lose data on the card.

### Removing a Memory Card

When you're finished printing from a memory card, make sure the light next to the card slot is not flashing before you remove it.

**Caution:** Do not eject a card while the processing light is flashing, or you may lose data on the card.

To remove a CompactFlash or Microdrive card, press the eject button first. Then pull the card straight out of the slot.

To remove a Memory Stick or SmartMedia card, simply pull the card straight out of the slot.
Connecting a Digital Camera or External Storage Device

If you have one of the following devices, you can connect it directly to your printer using a USB cable:

- Direct Connect Compatible (DCC™) digital camera with USB support
- 100 or 250MB Iomega Zip drive, AC or USB powered
- Secure Digital or MultiMediaCard (using a commercially available USB adapter, such as the MicroTech ZiO!)

**Note:** For a list of Direct Connect Compatible (DCC) cameras that EPSON has tested with your printer, visit http://support.epson.com and go to the specifications page for the EPSON Stylus 925. If you’re not sure about your camera, you can try connecting it. If it’s not compatible, you’ll see a screen saying that the connected device cannot be used.

EPSON cannot guarantee the compatibility of any cameras, including those DCC digital cameras that are known to support the Direct Connect feature, listed on the EPSON web site. Compatibility may be affected by factors such as changes in camera hardware or software interfaces.

If you are using a Zip disk, it must be formatted as a FAT16 disk. Also, if you insert a Macintosh disk into a Zip drive attached to the printer, it automatically formats it, so be sure to use a disk that is empty or not formatted, or one containing data you don’t mind losing. (You will be prompted before any data is erased.)

When you connect a digital camera or storage device, the printer treats it exactly like a memory card. Follow these steps to connect it:

1. Remove any memory cards from the printer.

(If you leave a card in the printer, images will be read from the card instead of your camera or external storage device.)
2. Connect the USB cable from your camera or data storage device to the back of the printer. Some digital cameras require a special USB cable; if so, be sure to use the one that came with the camera.

3. Turn on the printer and your camera or data storage device. After a moment, the printer reads and counts the number of images on your device. When it's done, you see a screen similar to this on the printer's control panel and your images are available for printing:

   ![Printer Control Panel](image)

   Note: If you've backed up your images on Zip disk (page 43), they're stored in folders (001, 002, etc.). Use the  and  buttons on the printer's control panel to highlight the folder you want to open, then press  to open it.
Selecting Photos for Printing

Before selecting the photos you want to print, make sure you have inserted your memory card or connected your camera to the printer, as described on page 19.

■ Unless you have the optional preview monitor (shown to the right), it’s a good idea to start by printing an index, so you can select your photos by number.

**Note:** The optional preview monitor (EPSON part number C12C860005) makes it easy to select your photos. See page 107 for ordering information.

Once you know which photos are available for printing, you can select a single photo (page 24), or a set of photos or all the photos (page 25).

■ If you’ve used your camera’s DPOF (Digital Print Order Format) feature to select the photos you want to print, you won’t have to print an index. When you insert the camera’s memory card or connect the camera to the printer, **DPOF** displays as the Print Mode and your photos are automatically selected. (If you don’t want to use DPOF, you can choose a different Print Mode.) See page 26 for details.

**Printing an Index**

An index print shows small, numbered images of all the photos on your memory card—and includes the date each picture was taken. This enables you to select the photos you want to print. If you have the optional preview monitor, you may not need to print an index.

1. Make sure your memory card is inserted and plain paper is loaded in the printer.

   **Tip:** If you scroll down (use the button on the control panel), you can see the total number of photos on the card.

2. Press the **Cancel** button to clear any settings you may have made. **Index** is automatically selected as the Print Mode setting:

3. Press the **Print** button. Your index starts printing.
**Selecting One Photo**

You can select a photo, then print one or more copies of it on a page using a variety of layouts. With the Copies option, you can print up to 100 copies of your selected layout.

If you don't have the optional preview monitor, first print an index to identify the photos on the memory card (as described on page 23).

1. Press the Cancel button to clear any previous settings.
2. Highlight Print Mode, then press the Select button.
3. In the Print Mode menu, use the and buttons to highlight One, then press to select it. This is the option for printing a single photo.

4. Highlight the Select Photo menu, then press the Select button.
   
   Use the and buttons to select the photo you want to print, then press .

5. Continue with “Printing Your Selected Photos” on page 27 to finish laying out your photos and setting up your print job.
Selecting a Set of Photos

You can select two or more photos, then print them as a group using a variety of layouts. If you’ve selected more photos than can fit on a page, the printer automatically prints additional pages as needed, using the same layout.

If you don’t have the optional preview monitor, first print an index to identify the photos on the memory card (as described on page 23).

1. Press the Cancel button to clear any previous settings.
2. Highlight Print Mode, then press the Select button.
3. In the Print Mode menu, highlight Set then press . This is the option for printing multiple photos.

**Note:** If you want to print all your photos, select All as the Print Mode.

4. Use the button to highlight Select Photo, then press .
5. Highlight Select, press , then press again.
   
   If you have the optional preview monitor, it displays the first photo on your card.
6. Use the and buttons to select the first photo you want to print, then press .

7. If you want to print more than one copy of this photo, use the button to highlight Copies, then press .
   
   Use the and buttons to select the desired number of copies, then press .
8. When you’re done selecting your first photo, use the button to highlight Enter, then press .
9. Repeat steps 5 through 8 for each additional photo you want to print.
10. When you're done, your list of selected photos is displayed. (If you've selected four or more photos, use the button to scroll up and view the rest of them.)

**Note:** If you made a mistake and selected the wrong photo, you can remove it from the list of selected photos. Simply change its number of copies to zero; see step 7. (Do not press Cancel, or all your settings will be canceled.)

11. Use the button to highlight Close, then press . Your photos are selected for printing.

12. Continue with “Printing Your Selected Photos” on page 27 to finish laying out your photos and setting up your print job.

**Using DPOF to Select Your Photos**

If your camera supports DPOF (Digital Print Order Format), you can use it to select photos for printing; see your camera's instruction manual for details. When you connect your camera or insert its memory card, DPOF automatically displays as the Print Mode. Your photos and the number of copies you want to print are already selected.

To print, continue with “Printing Your Selected Photos” on page 27 to finish laying out your photos and setting up your print job.

If you don't want to use DPOF, you can turn it off by selecting a different Print Mode. (Press the Cancel button; this clears any current settings and automatically highlights Print Mode. Press the Select button, then use the and buttons to highlight the Print Mode you want to use. Press to activate it.)
Printing Your Selected Photos

Once you've selected your photos, follow these steps to start printing:

1. Load your paper in the printer, as described on page 11 (for individual sheets) or page 13 (for roll paper).
   
   **Note:** If you’re not sure which type of paper to use, see “Choosing the Paper for Your Project” on page 8.

2. Enter the **Paper Type** menu. Highlight the type of paper you’ve loaded, then press ☑ **Select**. If you’re not sure about the paper type, see the table on page 29.

   **Note:** It’s important to select the correct Paper Type setting for the paper you’re using, or the print quality may not be what you expect.

3. Enter the **Paper Size** menu, then select the size of paper you’ve loaded. For example, if you’re printing with roll paper, select **4” Roll**.

4. In the **Layout** menu, select one of the following (see page 30 for a list of the resulting photo sizes for each layout):

   - Prints one photo per sheet, borderless; fits the photo lengthwise on the paper.
   - Roll paper only. Prints one photo, borderless; fits the photo across the paper.
   - Prints one photo per sheet, with borders around the edges.
   - Prints two photos per sheet.
   - Prints three photos per sheet.
   - Prints four photos per sheet.
   - Prints nine photos per sheet.
   - Prints 20 photos per sheet; the photo number and date are also printed with each photo. (Good for printing larger-size index prints.)
   - Roll paper only. Prints one photo per sheet, borderless; the long edge of each photo prints along the length of the paper, and the photo is cropped to create a “panoramic” look.
   - Prints six of the same photo per sheet, in various sizes.
Note: See “Printing Special Layouts” on page 38 for additional layouts.

5. If you've selected a single photo for printing (Print Mode is set to One, as described on page 24), you can print multiple sheets of your selected layout. Enter the Copies menu, then select from 1 to 100 copies. (You can also use Copies if you've selected All as your Print Mode.)

If you've selected a set of photos for printing, or if you're using DPOF, the number of pages required to print the photos is automatically determined (it's displayed as Pages next to the Copies setting); you cannot change this setting.

6. To adjust the quality of your printout, enter the Quality menu. Choose from these settings (some of them may not be available, depending on your selected Paper Type):
   - Normal: for the fastest print speed; good for drafts
   - High: for photo-quality output
   - Super High: for the highest quality output; takes a little longer, but recommended for photo-lab quality

7. If you like, you can make further changes before printing. See “Touching Up Your Photos” on page 33, “Cropping and Sizing Your Photos” on page 35, and “Adding Crop Marks and Photo Information” on page 37.

8. Press the Print button. Your print job begins printing.

You can prepare up to four additional print jobs while your first one is printing. You can select different photos to print, but you can't change the paper size or type, or select a layout that requires using a different paper size or type. If you want to print on different paper, wait until the printer has finished printing.

Note: To cancel a print job while printing, press the Cancel button.

Keep your pictures and unused paper away from high temperatures and humidity and out of direct sunlight. See page 16 for more information about storing and displaying your pictures.
Selecting the Correct Paper Type

When printing, be sure to select the correct Paper Type setting (step 2 on page 27). This tells the printer what kind of paper you're using so it can adjust the ink coverage accordingly.

Here are the settings you should choose from your printer's control panel when not using your computer to print:

<table>
<thead>
<tr>
<th>For this paper . . .</th>
<th>Select this Paper Type setting . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>Plain</td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td>GlossyPhoto</td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>GlossyPhoto</td>
</tr>
<tr>
<td>EPSON Premium Glossy Photo Paper</td>
<td>Prem.Glossy</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper</td>
<td>Semigloss</td>
</tr>
<tr>
<td>EPSON Premium Luster Photo Paper</td>
<td>Prem.Luster</td>
</tr>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td>Matte</td>
</tr>
<tr>
<td>EPSON ColorLife Photo Paper</td>
<td>ColorLife</td>
</tr>
<tr>
<td>EPSON Photo Stickers</td>
<td>Stickers</td>
</tr>
<tr>
<td>EPSON Iron-On Transfer Paper</td>
<td>Iron-on</td>
</tr>
<tr>
<td>EPSON Glossy Photo Greeting Cards</td>
<td>Greeting</td>
</tr>
</tbody>
</table>
Planning the Size of Your Photos

The printer automatically adjusts the size of your photos according to the paper size and layout you choose (steps 3 and 4 on pages 27 and 27). To get one of the photo sizes listed below, select an appropriate combination of paper size and page layout:

<table>
<thead>
<tr>
<th>Paper size</th>
<th>Page layout</th>
<th>Size of each photo (inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Letter</td>
<td>8.5 x 11</td>
<td></td>
</tr>
<tr>
<td></td>
<td>8 x 10</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 x 7</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.5 x 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.5 x 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.5 x 3.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 x 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x 6</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3.5 x 5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.5 x 3.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.5 x 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.5 x 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 x 1.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.8 x 0.9</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Paper size</th>
<th>Page layout</th>
<th>Size of each photo (inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td>5 x 7</td>
<td>5 x 7</td>
<td></td>
</tr>
<tr>
<td>4 x 6</td>
<td>4 x 6</td>
<td></td>
</tr>
<tr>
<td>3.5 x 5</td>
<td>5 x 7</td>
<td></td>
</tr>
<tr>
<td>2.5 x 3.5</td>
<td>4 x 6</td>
<td></td>
</tr>
<tr>
<td>1.5 x 2</td>
<td>4 x 6</td>
<td></td>
</tr>
<tr>
<td>1.5 x 2</td>
<td>2.5 x 3.5</td>
<td></td>
</tr>
<tr>
<td>1 x 1.5</td>
<td>2 x 2.5</td>
<td></td>
</tr>
<tr>
<td>0.8 x 0.9</td>
<td>2 x 2</td>
<td></td>
</tr>
</tbody>
</table>
You can print photos the following sizes on 4-inch roll paper:

<table>
<thead>
<tr>
<th>Paper size</th>
<th>Page layout</th>
<th>Size of each photo (inches)</th>
</tr>
</thead>
<tbody>
<tr>
<td>4-inch wide</td>
<td>4 × 6</td>
<td></td>
</tr>
<tr>
<td>roll</td>
<td>2.6 × 4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2.5 × 3.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.5 × 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1.5 × 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>1 × 1.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0.8 × 0.9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 × 11</td>
<td>(maximum)</td>
</tr>
</tbody>
</table>
One-Touch Printing

If there are certain settings you use quite often—for example, if you like to print 3.5 × 5-inch snapshots on Premium Glossy Photo Paper using 4-inch rolls—you can create your own custom settings and recall them at any time by pressing one of the Custom buttons.

Follow these steps to create custom settings:

1. From the control panel, select any of the following settings you want to use:

<table>
<thead>
<tr>
<th>Standard settings</th>
<th>Advanced settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print Mode</td>
<td>Automatic Correction</td>
</tr>
<tr>
<td>Paper Type</td>
<td>Enhancements</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Brightness</td>
</tr>
<tr>
<td>Layout</td>
<td>Saturation</td>
</tr>
<tr>
<td>Quality</td>
<td>Sharpness</td>
</tr>
</tbody>
</table>

2. Select which Custom button (1 or 2) you want to program with your settings. Then press and hold the button for at least three seconds, until you see a message saying that your settings have been saved.

When you want to print, press the appropriate Custom button (1 or 2) to recall your settings. Make sure the correct paper is loaded, then press Print.

Tip: If you like, you can further adjust any of the recalled settings after pressing the Custom button (before printing); any additional changes you make affect only the current print job and are not saved with your custom settings.

It’s a good idea to make a note of the settings you’ve programmed into each button.
Touching Up Your Photos

The EPSON Stylus Photo 925 lets you correct the color and improve the image quality of your photos even without a computer. Two basic types of adjustments are available.

**Note:** These settings affect only your printed pictures. They do not change your original image files.

- **Automatic adjustments (see below)**
  
  If your camera supports PRINT Image Matching, you can use the printer’s P.I.M. setting to automatically adjust your photos for the best results. This option is automatically selected when pictures imported from your camera contain P.I.M. data.
  
  If your camera doesn't support PRINT Image Matching, you can use PhotoEnhance™ to make adjustments for the type of environment in which your photos were taken.

- **Manual adjustments (see page 34)**
  
  If you find that your photos are too light or too dark, you can adjust their brightness manually, or make other corrections by controlling the saturation and sharpness. You can either make the same adjustments to all your photos, or separate adjustments only to selected photos.
  
  If you want, you can make manual adjustments while P.I.M. or PhotoEnhance is turned on in order to fine-tune your automatic settings.

**Automatically Adjusting Your Photos**

When you use the printer's automatic image adjustments, the adjustments are applied to all your photos (you can’t select individual photos for adjustment). However, you can make manual adjustments in addition to ones provided by P.I.M. or PhotoEnhance. Follow these steps:

1. Enter the **Advanced Settings** menu.
2. Highlight **Automatic Correction**, then press \( \text{Select} \).
3. Choose from these options:

- **P.I.M.** uses your camera’s PRINT Image Matching settings (this option is automatically selected when your pictures contain P.I.M. data).

- **PhotoEnhance** adjusts your photos based on your subjects or the environment in which they are photographed. After selecting PhotoEnhance, open the Enhancements menu. Then select from Standard, People, Scenery, Sunset, Night, Backlit, or Macro.

- **None** if you don’t want to use P.I.M. or PhotoEnhance.

4. To make manual adjustments in addition to the automatic ones provided by P.I.M. or PhotoEnhance, follow the steps in the next section.

**Manually Adjusting Your Photos**

To make manual adjustments to your photos’ brightness, saturation, or sharpness, follow these steps:

1. Make sure you’ve selected the photos you want to print.

2. Enter the Advanced Settings menu.

3. If you’re printing just one photo, or if you’re printing multiple photos and want to make the same adjustments to all of them, skip to step 5.

4. To make separate adjustments to selected photos, highlight **Photo Number**, then press ⊕ Select. Select the first photo by number, press ⊕ Select, then make any desired adjustments as described in the following steps. Repeat for any remaining photos you wish to adjust.

If you change your mind and want to make the same adjustments to all your photos, highlight **All**, press ⊕ Select, and make any adjustments.

5. Highlight **Brightness**, **Saturation**, or **Sharpness**, as needed, then press ⊕ Select. The printer lets you make five different selections for each setting.

After making your selection, be sure to press ⊕ Select to make your selection active.
Cropping and Sizing Your Photos

The EPSON Stylus Photo 925 lets you decide how your photos fit on the page with two options: **Crop** and **Fit to Frame**. You can apply these options to all your photos, or just to selected photos.

**Note:** The optional preview monitor (EPSON part number C12C860005) lets you see how your photos will be cropped. See page 107 for ordering information.

1. Make sure you’ve selected the photos you want to print.
2. Enter the **Advanced Settings** menu (use the and buttons to highlight **Advanced Settings**, then press **Select**).
3. If you’re printing just one photo, or if you’re printing multiple photos and want to make the same adjustments to all of them, skip to step 5.
4. To make separate adjustments to selected photos, highlight **Photo Number**, then press **Select**. Select the first photo by number, press **Select**, then make any desired adjustments as described in the following steps. Repeat for any remaining photos you wish to adjust.

   If you change your mind and want to make the same adjustments to all your photos, highlight **All**, press **Select**, and make any adjustments.

5. If you want to print only a portion of your image, highlight **Crop** then press **Select**. You can choose from 18 preset cropping options:

   - Upper Left 1.2×
   - Upper Center 1.2×
   - Upper Right 1.2×
   - Upper Left 1.5×
   - Upper Center 1.5×
   - Upper Right 1.5×
   - Center Left 1.2×
   - Center 1.2×
   - Center Right 1.2×
   - Center Left 1.5×
   - Center 1.5×
   - Center Right 1.5×
   - Lower Left 1.2×
   - Lower Center 1.2×
   - Lower Right 1.2×
   - Lower Left 1.5×
   - Lower Center 1.5×
   - Lower Right 1.5×

   The dimensions 1.2× and 1.5× indicate how much of your photo is cropped. For example, if you select 1.5×, it crops more of the image than if you select 1.2×.
If you’re using the optional preview monitor, you see a yellow border around the cropped area (shown in black below). Use the border only as a rough guide, since it does not indicate the exact area of your cropped image.

6. If your photo is too long or wide to fit inside the available space on your selected layout, part of the image will be automatically cropped. If you want to reduce the photo size so that no cropping occurs, open the **Fit to Frame** menu, then select **Off** and press **Select**.
Adding Crop Marks and Photo Information

Depending on the layout you choose, you can add crop marks (cutting marks) to guide you in cutting out your photos. You can also print information such as your camera settings and the date and time your photos were taken directly on your printed photos.

**Printing Crop Marks**

Except on letter-size paper, you can add crop marks to all your photos when printing two or four photos per sheet. Crop marks help you make even borders when trimming your photos. Follow these steps:

1. Enter the Advanced Settings menu.
2. Highlight Crop Marks, then press Select.
   (Be careful not to select Crop, which trims your photos before printing; see page 34.)
3. To turn crop marks on, highlight Include then press Select.

When Crop Marks is turned on, the marks print on all photos in any layouts for which they are allowed. This setting is saved when you turn off the printer or choose a different set of photos, so remember to turn the setting off if you no longer want to print with crop marks.

**Adding Photo Information**

If space is available, you can print the date and time each photo was taken, as well as the camera settings, in the lower right corner of your photos. These options are available for most layouts in which your printed photos are at least 3.5 inches wide.

1. Enter the Advanced Settings menu.
2. To print the date, highlight Date, then press Select. Highlight the month, date, and year formatting option of your choice, then press Select.
3. To print the time, highlight Time, then press Select. Highlight 12-hour system or 24-hour system, and press Select.
4. To print your camera’s exposure time (shutter speed), F-stop (aperture), and ISO speed, highlight Photo Information, then press Select. Highlight On, then press Select to activate the setting.
When **Date**, **Time**, or **Photo Information** is turned on, the information prints on all photos in any layouts for which they are allowed. In some cases, this information may not print if your finished photos are not large enough to provide the necessary space. These settings are saved when you turn off the printer or choose a different set of photos, so remember to turn the settings off if you no longer want to print with them.

**Printing Special Layouts**

Using special EPSON paper, you can make fun, creative projects—stickers, greeting cards, and iron-on transfers—without even turning on your computer.

**Printing Stickers**

You can turn your favorite picture into photo stickers, and even add a whimsical frame around each one. Make sure you have a package of EPSON Photo Stickers (part number S041144).

1. Follow the instructions in the paper package to load a sheet of stickers with the two support sheets beneath it. Make sure the paper is loaded with the cut corner in the upper right.
2. Enter the **Paper Type** menu. Highlight the **Stickers** option, then press **Select**.

3. Select the photo(s) you want to use, as described on page 23.

4. If you want to adjust the resolution of your printout, enter the **Quality** menu. Choose from these settings:
   - **High**—for photo-quality output
   - **Super High**—for photo-lab quality output; takes a bit longer to print

5. If you want to make sure your image completely fills each sticker (without leaving a border or gap at the sides), enter the **Advanced Settings** menu and make sure **Fit to Frame** is set to **On**. (If your image is not the same shape as each sticker, a portion of it will print outside the sticker and get cut off.)

6. Optionally, you can make further changes before printing. See “Adding Frames to Your Stickers” below. If you want to adjust the color or image quality, see page 33; to crop or size your photos, see page 35.

7. Press the **Print** button. Your stickers begin printing.

   If your photos didn’t align properly with the stickers, you can adjust their exact print position; see “Aligning Your Stickers” on page 40.

### Adding Frames to Your Stickers

You can print photo stickers with any of five whimsical frames. Follow the steps above to set up your stickers for printing. Then follow the steps below to add a frame before you print.

1. Enter the **Advanced Settings** menu.

2. Select **Frame** (don’t confuse this with **Fit to Frame**).

3. Highlight one of the available options: **Fish**, **Space**, **Fireworks**, **Alligator**, or **Frog**—or **None** if you don’t want a frame. Then press **Select**.

   **Note:** If you have the optional preview monitor, you can see the frames and preview your results before printing. If you don’t have the monitor, you can print samples of the frames. Make sure a memory card is inserted, then enter the **Advanced Settings** menu and select **Print Frame Samples**.
**Aligning Your Stickers**

If you notice that your photos are slightly off-center, you can adjust their position by up to 2.5 mm (about 1/8 inch) in any direction.

1. Enter the Advanced Settings menu.
2. Select one of these options:
   - Sticker Adjustment: Up/Down
   - Sticker Adjustment: Left/Right
3. Use the ▼ and ▲ buttons to select how far to move the image, then press □ Select.

All your images move by the same amount in the directions shown below:
Printing Greeting Cards

With EPSON Glossy Photo Greeting Cards (part number S041606), you can create your own personalized cards by printing your photo right on the front of each card. (If your printer is connected to a computer, you can print a message inside the card, too.) Your Stylus Photo 925 lets you print your photo without borders, all the way to the edges of the card.

1. Follow the instructions in the paper package to load a sheet of greeting card paper with the support sheet behind it. Make sure the paper is loaded with the cut corner in the upper right.

2. Enter the Paper Type menu. Highlight the Greeting option, then press Select.
3. Select the photo you want to use, as described on page 23.
4. If you want to adjust the resolution of your printout, enter the Quality menu. Choose from these settings:
   - Normal—for the fastest print speed
   - High—for photo-quality output
   - Super High—for photo-lab quality output; takes a bit longer to print
5. To print without borders around your image, enter the Advanced Settings menu and make sure Fit to Frame is set to On. (If your image is not the same shape as the card, a portion of it will print beyond the perforation marks and get cut off.)
6. Optionally, you can adjust the color or image quality before printing (see page 33), or crop or size your photos (see page 35).
7. Press the Print button. Your greeting card begins printing.
Printing with Iron-On Transfer Paper

With EPSON Iron-On Transfer Paper (part number S041153, 20 sheets—or S041155, 50 sheets), you can transfer your photos and other images to T-shirts, aprons, or just about any cotton or cotton-blended fabric. The printer automatically creates a mirror-image of your photo so that any text looks correct once it’s transferred.

1. Follow the instructions in the paper package to load a sheet of transfer paper. Make sure the paper is loaded with the cut corner in the upper right.

2. Enter the Paper Type menu. Highlight the Iron-on option, then press Select.

3. Select the photo you want to use, as described on page 23.

4. Optionally, you can adjust the color or image quality before printing (see page 33), or crop or size your photos (see page 35).

5. Press the Print button. Your transfer image begins printing.

Follow the instructions that came with the paper to transfer your image to a T-shirt or other item.
Saving Your Image Files

If you don't have a computer, you can save the image files that are in your camera's memory card on a Zip disk. This lets you reuse the memory card without losing your original images. Once your images are stored on a Zip disk, you can retrieve them at any time for printing.

Note: To back up images, you need a 100 or 250MB Iomega Zip drive (AC or USB powered), available at most computer stores. To minimize backup time, use a 100MB disk with the 100MB drive or a 250MB disk with the 250MB drive. If you insert a Macintosh disk into a Zip drive attached to the printer, it automatically formats it, so be sure to use a disk that is empty or not formatted, or one containing data you don’t mind losing. (You will be prompted before any data is erased.)

Follow these steps to make a backup copy of the images on your memory card:

1. Make sure the printer is turned on and the memory card you want to back up is inserted in the printer.
2. If the printer is connected to your computer, unplug the USB cable.
3. Connect a USB cable from your Zip drive to the EXT. I/F port on the back of the printer.
4. Enter the Advanced Settings menu, then press Select.
5. Use the button to highlight Backup, then press Select.
6. Press the Custom 1 button to start the backup procedure; you may have to follow additional instructions on the printer screen. All the photos on your card are copied to your Zip drive. Depending on how many photos there are, this may take several minutes.

Caution: Once the backup starts, do not disconnect the cable or interrupt the process, or you may lose data.

To print images saved on your Zip disk, follow the instructions in “Connecting a Digital Camera or External Storage Device” on page 21.
Printing From Your Computer

When you print from your computer, your EPSON Stylus Photo 925 works like any other printer. You can edit and enhance photos, or create greeting cards and calendars, and then print them out. Before you start, make sure your printer software is installed as described on the Start Here sheet.

Note: To print photos from your computer, you can use a program like Film Factory or ArcSoft PhotoImpression, which are included on the CD-ROM that came with your printer. For instructions on using Film Factory, see page 73; if you’re using PhotoImpression, use the program’s Help utility.

If you're printing digital photos from your camera, you can automatically copy them to your computer just by inserting the camera's memory card in your printer. See page 46 for more information.

If your digital camera supports PRINT Image Matching (P.I.M. or P.I.M. II) or Exif Print, you can use these technologies to ensure the most accurate reproduction of your photographs. See page 73.

For all types of printing, follow the instructions in these sections:

- “Copying Photos to Your Computer” on page 46
- “Basic Printing in Windows” on page 49
- “Basic Printing on a Macintosh” on page 53
- “Printing Borderless Photos” on page 60
- “Printing on Roll Paper” on page 63
- “Customizing Your Print Settings” on page 68
- “Selecting the Correct Media Type” on page 72
- “Using PRINT Image Matching” on page 73
Printing From Your Computer

Copying Photos to Your Computer

If you've taken digital photos with your camera, you can copy them to your computer using PhotoStarter and CardMonitor. These utility programs were automatically installed with your printer driver, and they detect when you insert a memory card in your printer and automatically copy the photos to your computer.

**Note:** If you're using Windows XP or OS X, you don't need these programs. You can set up Windows and the Macintosh to automatically copy photos to your computer when you insert a memory card. See your Windows or Macintosh Help for more information.

1. Make sure your computer and printer are connected by a USB cable and turned on.
2. Insert the memory card into the appropriate slot, as shown:

- [Compact Flash or Microdrive](bottom)
- [Memory Stick](middle)
- [SmartMedia](top)

If you're using a CompactFlash or Microdrive card, insert it all the way. If you're using a Memory Stick or SmartMedia card, it won't be possible to insert it fully; this is normal.

Avoid inserting more than one card at a time, or you may not be able to tell which card the printer is taking the images from.

3. PhotoStarter opens and copies your pictures to the Photos folder on your desktop.

If this is the first time you've inserted a memory card, you see this message instead. Follow the instructions in the next section to respond to the message and configure the PhotoStarter utility.

4. When done copying your photos, remove the card as described on page 48.

**Caution:** If you access the card from your computer and delete files, the card may not work correctly with your camera. Always delete pictures using your camera.
Configuring PhotoStarter

Follow these steps to configure PhotoStarter:

1. When you see the message on page 46, click **Next**. The PhotoStarter setup assistant opens:

2. Click **Next** again. The setup assistant asks you a series of questions about how you want PhotoStarter to work.

   The default settings do the following whenever you insert a memory card:
   - PhotoStarter copies your pictures to the Photos folder on your desktop.
   - The pictures are stored in folders by date.
   - Film Factory opens automatically.

   **Note:** Film Factory lets you view, modify, and print photos from your computer quickly and easily. To learn more about this program, see page 73.

3. Change any of the settings you want, then click **Next**. When you see the Confirmation window, click **End**.

   You can go back and change settings at any time by opening PhotoStarter:
   - In Windows, click **Start**, point to **Programs** (or **All Programs**), Film Factory, and click **EPSON PhotoStarter 3.0**. Open the **Settings** menu and choose **Change Settings**.
   - On a Macintosh, open the **EPSON PhotoStarter** folder, then select **EPSON PhotoStarter**. Open the **Tools** menu and choose **Change Settings**.
Removing a Memory Card

Once you're finished copying photos from your memory card, follow the steps below to remove it. You should also remove any cards before unplugging the USB cable from your printer.

**Caution:** Do not eject a card while the processing light is flashing, or without performing the steps described below, or you may lose data on the card. Be sure all cards have been removed before unplugging the USB cable.

1. Depending on your operating system, you may need to do one of the following:
   - On a Macintosh, drag the memory card icon from your desktop to the trash. If you remove the card without doing this, an error message remains on your screen until you reinsert the card.
   - If you're using Windows XP or 2000, click the **Unplug or Eject Hardware** icon on the taskbar. Then use the Windows controls to stop the **EPSON Mass Storage Device**.

2. To remove a Memory Stick or SmartMedia card, pull it straight out of the slot. To remove a CompactFlash or Microdrive card, press the eject button first, then pull out the card.
Basic Printing in Windows

After you create your document (such as a photograph, letter, or school project) in a Windows application, follow these steps to print it:

1. From the File menu, click Print. You see a Print window (your window may look slightly different):

2. Make sure EPSON Stylus Photo 925 is selected.

3. Click the Properties or Preferences button. (If you see a Setup, Printer, or Options button, click it. Then click Properties or Preferences on the next screen.)
You see your printer settings window.

The most important thing to remember is to set the correct Media Type for the paper you're using.

4. Make the following settings on the printer settings window:

- Choose the paper you're printing on (click the arrow to scroll through the Media Type list). If you're not sure which setting to select, see page 72.
- Set the Ink option to Color to print a color document or a black-and-white photograph. To print a black text document, click Black.
- Set the Mode option to Automatic. It's the easiest way to get good printing results on all types of paper.
- Set the slider in the Mode box to Quality or Speed to select higher quality or faster printing (the slider may not be available, depending on your selected paper type).
5. Click the **Paper** tab at the top of the window if you need to change the paper source (sheet feeder or roll paper), paper size, number of copies, page orientation, or printable area.

**Note:** To print without borders, see page 60. To print on roll paper, see page 63. To print double-sided pages, refer to your on-screen *Reference Guide* (see page 5).

If you want borders around the photo, click the **Centered** checkbox to make sure the border is even on all sides.

6. Click the **Layout** tab if you want to reduce or enlarge your printed image, print multi-page layouts, or add a watermark.

7. Click **OK** until you see the Print window again.

**Tip:** For more information about printer settings, click the Help button. Or right-click any item on the screen and then click What’s This?.
8. At the Print window, click OK (or Print) to start printing.

After a moment, this window appears and shows the progress of your print job. You can use the buttons to cancel, pause, or resume printing. You can also see how much ink you have left.

For more information on printing—for example, previewing your printout or adding a watermark—see your on-screen Reference Guide (described on page 3).

**Note:** Keep your pictures and unused paper away from high temperatures and humidity and out of direct sunlight. See page 16 for more information about storing and displaying your pictures.
Selecting the Settings You Use Most Often

Your printer settings apply only to the program you’re currently using. If you usually print one type of document in different programs—for example, black-and-white photos on 8 x 10 paper—you can change the default printer settings for all your programs. You do this using the Windows Printers utility.

1. Right-click the printer icon on your taskbar, in the lower-right corner of your screen. (In Windows XP, access the Printers and Faxes window through the Control Panel, then right-click your printer icon.)

2. Select Printer Settings (or Printing Preferences in Windows XP). You see your printer settings window, as shown on page 50.

3. Select the default settings you want to use for all your applications. Click OK when you’re finished.

Remember that you can always change the settings in your program when you want to print different types of documents.

Basic Printing on a Macintosh

After you create your document—such as a photograph, letter, or school project—follow the basic steps in one of these sections to print it:

- For Macintosh OS 8.6 to 9.x applications, see page 54.
- For Macintosh OS X applications, see page 56.
Printing with OS 8.6 to 9.x

1. From the File menu, select Page Setup. You see the following:

![Page Setup window](image)

Make sure you see SP 925
Select your paper size
Select the orientation of your document

2. Make sure SP 925 is selected. If not, you need to select your printer in the Chooser.

3. Select the correct Paper Size, Orientation, and other settings. Then click OK.

   **Note:** To print without borders, see page 60. To print on roll paper, see page 63. To print double-sided pages, refer to your on-screen Reference Guide (see page 5).

4. From the File menu, select Print. You see a window like the following:

![Print window](image)

Select the type of paper you loaded
Select the Ink color
Select Automatic mode
Select higher quality or faster printing

The most important thing to remember is to set the correct Media Type for the paper you're using.
5. Make the following settings:

- Choose the paper you’re printing on (click the arrow to scroll through the Media Type list). If you’re not sure which setting to select, see page 72.
- Set the Ink option to Color to print a color document or black-and-white photo. To print a black text document, click Black.
- Set the Mode option to Automatic. It’s the easiest way to get good printing results on all types of paper.
- Set the slider in the Mode box to Quality or Speed to select high-quality printing or faster printing (not available for all paper types).

You can also do the following:

- Click \( \) to reduce or enlarge your image, print multi-page layouts, or add a watermark.
- Click \( \) to control background printing and schedule print jobs.
- Click \( \) to change the Print button to Preview. You can then click it to preview your printout.
- Click \( \) to check your ink levels.

**Tip:** For more information about printer settings, click the ? button.

6. Click Print to start printing. If you turned on background printing, you can open the EPSON Monitor3 window by selecting it in the Application menu in the upper-right corner of your screen.
If you’re not using background printing and you need to cancel printing, hold down the ` key and press the . (period) key. For more information on printing—for example, printing posters or adding a watermark—see your on-screen Reference Guide (described on page 3).

**Note:** Keep your pictures and unused paper away from high temperatures and humidity and out of direct sunlight. See page 16 for more information about storing and displaying your pictures.

**Printing in OS X**

If you’re using an OS X compatible printing application, follow the steps below to print a document. (If you’re using an application that’s compatible only with Macintosh Classic mode, follow the steps on page 54 instead.)

Before you begin, make sure you added your printer to Print Center and added the OS X printer features as described on the Start Here poster.

1. From the File menu, select Page Setup. You see this menu:

   ![Page Setup Menu](image)

   - Select the Stylus Photo 925 and printer feature
   - Select the Paper Size and Orientation settings

2. Open the Format for pull-down menu and select the Stylus Photo 925 printer feature you are using:
   
   (See page 60 for details about printing borderless photos and page 63 for information on using roll paper.)

3. Select the correct paper size from the Paper Size menu.
Caution: When printing borderless photos, select one of the supported paper sizes for your printer. Never select a custom or unsupported paper size, as this may cause ink to spray inside your printer.

When printing with borders using a custom paper size, make sure the selected size matches the paper you loaded and is within the printable area for the printer. For example, never choose a size wider than the printer’s sheet feeder or longer than the paper. (See the Reference Guide for printer specifications.)

4. If you want to change the orientation of your printout, click the appropriate button.
5. When you’re finished with the Page Setup settings, click OK.
6. Select Print from the File menu. You see a screen like this:

7. Open the Printer pull-down menu and select the same printer feature setting you chose in the Format for menu in the Page Setup window.
8. Select Print Settings from the Copies & Pages pull-down menu.
9. Select the following Print Settings as necessary:

![Print Settings Diagram]

Tip: For more information about printer settings, click Help. The OS X printer driver contains a subset of the settings available with the OS 8.6 to 9.x Macintosh printer driver described in this book.

10. You can also choose other print settings by selecting these options in the pull-down menu:
   - **Copies & Pages**, to select the number of copies or a page range
   - **Layout**, to select page layout options
   - **Output Options**, to save your print job as a PDF file
   - **Color Management**, to select ColorSync® adjust the color controls, change the gamma setting, or turn off color adjustments by the printer software
   - **Roll Paper Option**, to select the Auto Cutter options (such as Manual Cut, Paper-Saving Cut, or Normal Cut) and the Roll Paper Options (Banner, Cut sheet, Save roll paper, or Print page frame). See page 64 for more information.
   - **Summary**, to view a list of all your selections
   - **Save Custom Setting**, to save your selections for future use. (Not available with Mac OS X 10.2.x.)

11. Click Print.
12. To monitor the progress of your print job, click the Print Center icon when it appears in the dock. On OS X 10.2.x, double-click your printer option (such as Stylus Photo 925). You see a screen like this:

![Print Center screen](image)

13. Monitor the progress of your print job or do one of the following:

- Click the print job, then click **Delete** to delete the job
- Click the print job, then click **Hold** to pause printing
- Click a print job marked “Hold” and click **Resume** to resume printing
- If multiple print jobs are listed and you want one to print before the other(s), select the job and click the **Status** arrow to move it up.

14. When you’re finished, close Print Center.
Printing Borderless Photos

You can print your photos without margins, extending the image all the way to the edges of the page. Although borderless printing is a bit slower, you get beautiful snapshots or enlargements without trimming.

Borderless printing from your computer supports the following paper types and sizes:

*Individual Sheets*

<table>
<thead>
<tr>
<th>Paper name and description</th>
<th>Letter size</th>
<th>4 x 6</th>
<th>5 x 7</th>
<th>8 x 10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Glossy Photo Paper:</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Perfect for snapshots, reprints and enlargements</td>
<td></td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Premium Glossy Photo Paper:</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>High gloss photos for framing and albums</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Premium Semigloss Photo Paper:</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Semigloss photos for framing and albums</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Premium Luster Photo Paper:</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Perfect for portraits with a textured surface</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Matte Paper Heavyweight:</td>
<td>✓</td>
<td></td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Highest-quality matte photos</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*Roll Paper*

<table>
<thead>
<tr>
<th>Paper name and description</th>
<th>4-inch roll paper</th>
<th>8.3-inch roll paper</th>
</tr>
</thead>
<tbody>
<tr>
<td>Premium Glossy Photo Paper:</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>High gloss photos for framing and albums</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Premium Semigloss Photo Paper:</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Semigloss photos for framing and albums</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Premium Luster Photo Paper:</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Perfect for portraits with a textured surface</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To print without borders, load your paper as described on page 11 (for sheets) or page 13 (for roll paper), then follow the steps below for your operating system.

**Caution:** If you use an unsupported paper size, ink may get inside your printer and mar future printouts.
**Windows**

1. In your application, open the printer settings window and make any required settings as described on page 50.

2. Click the **Paper** tab. You see a window like the following:

3. Select the correct **Paper Source** and **Page Size**, and check the **Borderless** box.

   **Note:** If you are using roll paper, select the appropriate **Auto Cutter** option as described on page 64.

4. Click **OK**, then click **OK** or **Print**.
**Macintosh OS 8.6 to 9.x**

1. Select Page Setup from the File menu. You see this window:

   ![Page Setup Window](image)

   - Click the box for borderless printouts
   - Choose the paper size and source
   - Select a borderless option from the list
   - Choose the correct paper size

2. Select the correct Paper Source and Paper Size, and check the Borderless box.

   **Note:** If you are using roll paper, select the appropriate Auto Cutter option as described on page 64.

3. Click OK.

4. Select Print from the File menu and then click Print.

**Macintosh OS X**

1. Select Page Setup from the File menu. You see this window:

   ![Page Setup Window](image)

   - Select a borderless option from this list
   - Choose the correct paper size

---

62 Printing From Your Computer
2. Open the Format for menu and select the appropriate borderless option:

3. Choose the correct Paper Size.

4. Click OK.

5. Select Print from the File menu.

6. Open the Printer pull-down menu and select the same borderless option you chose in the Format for menu on the Page Setup window.

7. Click Print.

---

**Printing on Roll Paper**

You can print on 4” or 8.3” roll paper. Before you start, however, you need to tell the printer how to cut your photos. If you’re printing multiple photos, you can have the printer cut between them automatically, or you can print them out without cutting them. If you’re not cutting the photos as they come out of the printer, you can print a frame around each one to guide you in cutting them later.

**Note:** If the printer doesn’t cut the roll paper at the correct position between your photos, you can adjust it for a more exact cut. See “Aligning the Cutter” on page 90.

**Windows and Macintosh OS 8.6 to 9.x**

1. Load your roll paper, as described on page 13.

2. **Windows:** Open the printer settings window and make any required settings as described on page 50.

   **Note:** Be sure to select the correct Media Type setting for the roll paper that is loaded in the printer—such as Premium Glossy Photo Paper or Premium Luster Photo Paper. (See page 72.) Then click the **Paper** tab.

   **Macintosh:** Select **Page Setup** from the File menu and make any required settings as described on page 53.
You see a screen like the one below.

3. **Windows**: In the Paper Source box, select Roll 4in or Roll 8.3in.

   **Macintosh**: Select the paper size (such as 4 x 6 in for 4 inch roll paper) in the Paper Size box. Then select Roll Paper in the Paper Source box.

4. If you want to print without margins, click the **Borderless** checkbox.

5. Select one of these auto-cutting options:

   - **Paper-Saving Cut** (default option): Good for cutting photos with borders (white margins around the edges).
   - **Normal Cut** (available only when printing borderless photos): Use this option for best results when cutting borderless photos.
   - **Manual Cut**: Lets you cut photos yourself after they’re printed.

   **Note**: If you select Manual Cut, you can print a frame around your photos to help you cut them later. (This is useful if your photos all share the same background, making it hard to see where to cut them.) Under Roll Paper Option, select the option for printing cut sheets, then click the Print page frame checkbox.

   If you’ve set up the printer to cut your photos automatically, select a higher printer quality, such as Best Photo or Photo RPM, for best results (see page 69).

6. When you’re done making your roll paper settings, click OK.
7. **Windows**: Click **OK** or **Print**.

   **Macintosh**: Select **Print** from the File menu. Select the correct Media Type setting for the roll paper that is loaded in the printer. (See page 72.) Then click **Print**.

Once your photo is done printing, press the printer's roll paper button to cut and eject it. If you're printing multiple photos, wait for the last photo to finish printing before cutting it.

If you want to continue printing, you don't have to do anything special. Just select your printer options as usual; the roll paper is positioned automatically for your next print job.

**Macintosh OS X**

1. Load your roll paper, as described on page 13.
2. Select **Page Setup** from the File menu. You see this window:

   ![Page Setup Window]

   Select a roll paper option from this list

3. Open the Format for menu and select the appropriate roll paper option:
4. Choose the correct Paper Size.
5. Click **OK**.
6. Select **Print** from the File menu.
7. Open the Printer pull-down menu and select the same roll paper option you chose in the Format for menu on the Page Setup window.
8. Select **Roll Paper Option** from the Copies & Pages pull-down menu:

![Print dialog box](Image)

You see this menu:

![Print dialog box](Image)

9. Open the Auto Cutter pull-down menu and select one of the paper cutting options described on page 64.

10. Depending on the Auto Cutter option selected, you may need to choose a different Roll Paper Option button (such as **Banner** or **Cut sheet**).

11. Select **Print Settings** from the pull-down menu and select the correct Media Type option for the roll paper loaded in the printer. (See page 72 for more information.)

12. When you’re ready, click **Print**.

After your photo has been printed, press the printer’s roll paper button to cut and eject it. If you’re printing multiple photos, wait for the last photo to finish printing before cutting it.

If you want to continue printing, you don’t have to do anything special. Just select your printer options as usual; the roll paper is positioned automatically for your next print job.
Removing Roll Paper From the Printer

When you’re done printing on roll paper, follow these steps to remove it:

**Note:** Always keep unused paper in the original package.

1. Press the roll paper button and hold it down for about three seconds. The paper feeds all the way back and a message appears.

2. Turn the knobs on the roll paper holders to rewind the paper. (Make sure the paper is completely rewound on the roll.)

3. Press the roll paper button to clear the message.
Customizing Your Print Settings

You can use custom settings for color management, printing at higher resolutions, and selecting a variety of special effects.

Customizing Windows Print Settings

1. On the printer settings window, click Custom, then click the Custom Settings list to open it.

2. Select one of these settings:
   - ICM (Image Color Matching): For matching colors as closely as possible with ICM-compatible monitors or scanners.
   - sRGB (standard Red Green Blue): For color matching with other sRGB devices, or for images designed for the Web. See your Windows help for details.

3. If you're finished selecting custom settings, click OK to print your document.
   To select more custom settings, continue with the next step.
4. To access advanced settings, click Custom and then click the Advanced button. You see the Advanced window.

5. Select a higher print quality, if necessary. (Some settings may not be available, depending on your selected paper type.)

6. Select any other advanced settings you want to use. For details, click the Help button.

7. When done, click OK.

After customizing your print settings, you can save them as a group so you can reuse them whenever you print a similar project. Click Save Settings as shown above. When you want to reuse your settings, select them from the Custom settings list (shown on page 68).
**Customizing Macintosh Print Settings**

1. On the printer settings window, click Custom, then click the Custom Settings list to open it.

2. Select one of these settings:
   - **Economy**: For printing rough drafts of text on plain paper. Saves ink.
   - **ColorSync**: For matching colors to your screen as closely as possible, when used in conjunction with ColorSync-compatible devices and applications.

3. If you're finished selecting custom settings, click Print to print your document.
   To select more custom settings, continue with the next step.
4. To access advanced settings, click **Advanced** (OS 8.6 to 9.x) or **Advanced Settings** (OS X).

5. Select a higher print quality, if necessary. (Some settings may not be available, depending on your selected paper type.)

6. Adjust any Color Management settings, if necessary. (OS X: Select **Color Management** from the Print Settings menu.)

7. Select any other advanced settings you want to use. For details, click the ? button.

8. **OS 8.6 to 9.x**: Click **OK** to save your settings, then click **Print**.
   **OS X**: Click **Print**.
Selecting the Correct Media Type

When printing, always be sure to select the correct Media Type setting. This tells the printer what kind of paper you're using so it can adjust the ink coverage accordingly.

Here are the settings you should choose for your paper when printing from your computer:

<table>
<thead>
<tr>
<th>For this paper . . .</th>
<th>Select this Media Type setting . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper sheets or envelopes</td>
<td>Plain paper</td>
</tr>
<tr>
<td>EPSON Premium Bright White Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Iron-On Transfer Paper</td>
<td>360 dpi Ink Jet Paper</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Quality Self Adhesive Sheets</td>
<td></td>
</tr>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td>Matte Paper - Heavyweight</td>
</tr>
<tr>
<td>EPSON Double-Sided Matte Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td>Photo Paper</td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Photo Quality Glossy Paper</td>
<td></td>
</tr>
<tr>
<td>EPSON Glossy Photo Greeting Cards</td>
<td></td>
</tr>
<tr>
<td>EPSON Premium Glossy Photo Paper</td>
<td>Premium Glossy Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Luster Photo Paper</td>
<td>Premium Luster Photo Paper</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper</td>
<td>Premium Semigloss Photo Paper</td>
</tr>
<tr>
<td>EPSON Photo Stickers</td>
<td>Photo Quality Glossy Film</td>
</tr>
<tr>
<td>EPSON Photo Quality Glossy Film</td>
<td></td>
</tr>
<tr>
<td>EPSON Ink Jet Transparencies</td>
<td>Ink Jet Transparencies</td>
</tr>
<tr>
<td>EPSON ColorLife Photo Paper</td>
<td>ColorLife Photo Paper</td>
</tr>
</tbody>
</table>

The availability of paper types varies by location.
Using PRINT Image Matching

With PRINT Image Matching (P.I.M. or P.I.M. II), special print instructions are saved in your digital photo files. For example, macro mode pictures might include print commands for sharpness and clarity, while portrait mode pictures might emphasize soft focusing and subtle flesh tones. If your digital camera supports PRINT Image Matching, you can use this technology when you print with one of the following:

- Film Factory, as described below
- P.I.M. II Plug-in for Adobe Photoshop, as described on page 77
- ArcSoft PhotoImpression (see the help utility that comes with the program for printing instructions)

Using Film Factory

If your digital camera supports PRINT Image Matching or Exif Print, you can use these technologies when you print with Film Factory to ensure the most accurate image reproduction (not available with Macintosh OS X). Printing with P.I.M. isn't complicated, and it provides the color corrections right from your P.I.M. image file, so you don't have to correct them yourself. Just leave the PRINT Image Matching box checked.

You can also use Film Factory to organize, retouch, and print non-P.I.M. and non-Exif Print digital images.

Note: If you're using Mac OS X and want to print P.I.M.- and Exif Print-enabled digital photos, you can use the P.I.M. II Plug-in for Adobe Photoshop (described on page 77) if you have Photoshop 6.0 or 7.0, or Photoshop Elements 1.0 or 2.0.
Opening Your Photos in Film Factory

1. Start Film Factory. You see the main Film Factory screen:

   ![Film Factory Interface Diagram]

   Click Roll to create a new roll, or . . . click an existing roll

   PRINT Image Matching photos are marked here

   Note: If you need help with Film Factory, select it from the Help menu or check the on-screen Getting Started Guide that was installed with Film Factory.

2. Select a “roll of film” or click the Roll button and select New Roll.

3. If your photos were taken with a digital camera that supports PRINT Image Matching, the P.I.M. logo appears in your photo thumbnails. Right-click (Windows) or Ctrl-click (Macintosh) a photo thumbnail to display information about the P.I.M., P.I.M. II, or Exif Print data in the photo file. (If you retouched a PRINT Image Matching photo, the P.I.M. logo may not appear.)

4. Click the photo you want to print, or click the All button at the top of the screen to select all the photos in a roll. Then go to step 6.

5. To import a photo into Film Factory, click the Import button, then:
   - Click From File to import a photo from your computer’s hard drive.
   - Click From Removable Media to import a photo from a disk or CD-ROM.
   - Click From PC Card to import a photo from a PC card in a card reader.
   - Click From Twain Device to import a photo from a scanner or digital camera. If your device is already selected, the software will open. If not, click Import Settings, and select your scanner or digital camera. (Not applicable to OS X.)
6. Click a button on the left to select a print option. For example, click the **Standard Prints** button. You see buttons for each step you need to follow, as shown.

7. Click **Import & Retouch** to retouch or edit your photo, if necessary.

   **Note:** You can rotate, trim, and correct for red eyes and still retain Print Image Matching or Exif Print image quality with your photo. However, if you adjust other settings, such as brightness and color, your P.I.M. or Exif Print data and image quality will be lost.

   To ensure you keep P.I.M. or Exif Print data and image quality in your original photo file, make a copy of the photo before you edit. Then make edits only to your copy.

8. When you’re ready to print, continue with the steps in the next section.

**Printing Your Photos**

1. When you’re ready to print, click the **Print Assignment** button. You see this screen:
2. **Windows and Macintosh OS 8.6 to 9.x**: Select these options in the Printer Settings box at the bottom of the screen, in this order:

   1. Make sure your printer is selected.
   2. Select Sheet Feeder or Sheet Feeder (No Margins) for Borderless printing.
   3. Select your paper size.
   4. Select the Media Type.

**Macintosh OS X**: Click the Properties button. Select your printer in the Format for menu, select the correct Paper Size setting, and click OK.

3. If you want to print the current date with your photo, click the Print Date box.

4. Click the Print button on the left side of the screen. You see more options:

   - Select the number of copies you want to print.
   - Leave these boxes checked for the best printed output using P.I.M. and/or Exif Print data, if available.

5. If your photo doesn't look right in the preview, click the Back button to change your settings. (Click the Detailed Preview button for a closer look.)

6. Select the number of copies you want to print.

7. Leave the PRINT Image Matching and/or Exif Print box checked for the best results when printing photos containing P.I.M. and/or Exif Print data. (Not applicable to OS X.)
8. Click the Print button at the top of the screen.
   ■ Windows: Your pictures are printed.
   ■ Macintosh OS 8.6 to 9.x: You see the Print window; click Print. Your pictures are printed.
   ■ Macintosh OS X: You see the Print window.

Store your prints in resealable plastic bags, photo albums, or glass-covered picture frames. Keep your pictures and unused paper away from high temperatures, humidity, and direct sunlight. Make sure you return unused paper to its original package.

**Using the P.I.M. II Plug-in for Adobe Photoshop**

The P.I.M. II Plug-in for Adobe Photoshop allows you to retain the PRINT Image Matching or Exif Print image quality when you import JPEG or TIFF files from your P.I.M.-, P.I.M. II-, or Exif Print-enabled digital camera. The P.I.M. II Plug-in works with Photoshop 7.0, 6.0, and Photoshop Elements 1.0 and 2.0. You'll also need to use the ICC profiles for your printer that are installed with the plug-in (Windows) or the printer driver (Macintosh).

Photoshop doesn't retain the PRINT Image Matching or Exif Print information separately in the header file when you import your P.I.M., P.I.M. II, or Exif Print image. Instead, it converts that information in the file and embeds a color space called EPSON RGB 2001. This profile supports all the P.I.M. color advantages and enhancements.

You can crop, rotate, resize, work with layers, play with filters, and even make selective color adjustments to the P.I.M. image while retaining P.I.M. quality. However, you won't benefit from global color adjustments (such as Auto Levels, Auto Contrast, Auto Color, etc.). Also, if you try to use your new Photoshop file in another P.I.M.-enabled software program, it won't be recognized as a P.I.M. image. You need to keep your original file if you want to take advantage of P.I.M. information in other programs.

**Importing a P.I.M. Image**

**Note:** The examples in the sections below show Macintosh screens. Windows screens look slightly different, but the settings are the same.

1. If you're using Photoshop Elements, change your color settings before importing a P.I.M. image. Select Color Settings from the Edit menu, then select Full color management - optimized for Print and click OK.
2. Open the File menu and select Import > PRINT Image Matching. You see a window like this:

3. Select the folder containing your P.I.M. or Exif Print images. (In Windows, all your files are listed; on a Macintosh, only P.I.M. and Exif Print files appear.)

4. Select the image you want to import.

5. To see a preview of the P.I.M., Exif Print, or color extension effects for the selected image, check the Image Preview box. (In Windows, non-P.I.M. and non-Exif Print images cannot be previewed.)

6. Choose an import option:
   - PRINT Image Matching II enables the greatest range of image enhancements and effects. It also supports the EPSON RGB expanded color space, which is similar to the Adobe RGB color space and is required for PRINT Image Matching image quality prints. This setting is available only for P.I.M. and P.I.M. II images.
   - Exif Print enables Exif 2.2 effects and allows for an expanded color space. This option does not use P.I.M. II settings and is available only for files that contain Exif Print data.
   - Color extension only enables you to print using an expanded color space, but does not include P.I.M. II or Exif print effects, such as brightness, sharpness, and other settings. This option is available only for P.I.M. II and Exif Print images.

7. Click the Open button. Your image opens and the window remains on the screen.

   Note: If you see this screen, select Use the embedded profile and click OK.

8. Select and open more images, or click Cancel to close the Open PRINT Image Matching file window. (If you don't want the window to remain on the screen after you open a file, uncheck Import consecutively.)
9. Follow the steps in the next section to print your P.I.M. image.

To keep the P.I.M. header information intact for use in other P.I.M.-enabled programs, keep the original file; don’t use the Photoshop \texttt{Save} command. Instead use \texttt{Save As} to rename the file. It won’t contain P.I.M. header information, but will retain P.I.M. image quality, as long as the file is saved with the ICC profile embedded.

\textbf{Note:} If you overwrite your original file, you will lose all P.I.M. header information.

\section*{Printing a P.I.M. Image}

P.I.M. images are converted into the EPSON RGB 2001 color space. To retain P.I.M. quality and enhancements, don’t change the color space.

\textbf{Note:} The illustrations in the sections below show Macintosh screens; Windows screens will look different, but the settings are the same.

1. Open the File menu, then:

\textbf{Photoshop 7.0 or Elements}: Select \texttt{Print Preview > Print Options}, or \texttt{Print with Preview}. Then click \texttt{Show More Options > Color Management}.

\textbf{Photoshop 6.0}: Select \texttt{Print}.

You see one of these windows:

\begin{itemize}
\item In the Source Space box, make sure the \texttt{EPSON RGB 2001} option is selected.
\item In the Print Space box, select the \texttt{Stylus Photo 925} profile for the paper you’re printing on. We recommend \texttt{Perceptual} as the Intent setting.
\end{itemize}
4. **Photoshop 7.0 or Elements**: Click Print. You see the printer settings window.

   **Photoshop 6.0**: Go to step 5.

   In Windows, click **Setup**, then select your printer and click **Properties** or **Preferences** to select these settings.

5. Select the paper you’re printing on as the **Media Type**.

6. **Windows**: Click **Custom**, then click **Advanced**. You see the Advanced options.

   **Macintosh 8.6 to 9.x**: Under Mode, click **Custom**, then click the **Advanced** button. You see the Advanced screen.

   **Macintosh OS X**: Click **Advanced Settings** from the popup menu.

7. Select **Photo**, **Best Photo**, or **Photo RPM** as the **Print Quality**.

8. **Windows**: Select **No Color Adjustment** and click **OK**.

   **Macintosh 8.6 to 9.x**: Select **No Color Adjustment** and click **OK**.

   **Macintosh OS X**: Select **Color Management** from the pop-up menu, then select **No Color Adjustment**.
9. Continue clicking OK (Windows) or click Print (Macintosh) to print your photo.
Maintaining Your Printer

This chapter describes maintenance procedures to keep your printer working its best, and preparation steps for moving your printer. Follow the instructions here for:

- “Cleaning the Print Head” on page 84
- “Replacing an Ink Cartridge” on page 85
- “Aligning the Print Head” on page 89
- “Aligning the Cutter” on page 90
- “Cleaning the Printer” on page 91
- “Transporting the Printer” on page 92

For more details, read your on-screen Reference Guide (described on page 3).
Cleaning the Print Head

If your printouts are unexpectedly light or faint, or dots or lines are missing from the image, you may need to clean the print head. This un=clogs the nozzles so they can deliver ink properly. Print head cleaning uses ink, so clean it only if quality declines.

You can clean the print head either from the printer’s control panel or using your printer software. To clean using the printer software, the printer must be connected directly to your computer (not over a network); see your on-screen Reference Guide for details.

**Caution:** When you don’t turn on your printer for a long time, the print quality can decline, so turn it on at least once a month to maintain good print quality.

Running the Head Cleaning Utility

Follow these steps to run the head cleaning utility from the printer’s control panel:

1. Make sure the printer is turned on but not printing, and the red error light is off. (If the red light is flashing or on, you may need to replace the ink cartridge; see page 85 for details.)

2. Use the button to highlight **Advanced Settings**, then press the **Select** button.

3. Use the or button to highlight **Head Cleaning**, then press **Select**.

4. To begin cleaning, press **Custom** button 1.

   While cleaning, the printer makes noise and you see a progress bar on the control panel display. Cleaning takes about 30 seconds.

   **Caution:** Do not turn off the printer or interrupt the cleaning process.

5. When the cleaning is done, run a nozzle check to confirm the print head nozzles are clean.

   Make sure letter-size plain paper is loaded in the printer, then press **Custom** button 2. The nozzle check pattern prints (see the next section for details).

6. If the pattern has gaps or missing dots, press **Custom** button 1 to clean the print head again.

   If the nozzle check pattern looks correct, press **Custom** button 2 to finish.

   If you don’t see any improvement after cleaning three or four times, check the solutions beginning on page 97. You can also turn the printer off and wait overnight—this allows any dried ink to soften—and then try cleaning the print head again.
Examining the Nozzle Check Pattern

Examine the nozzle check pattern you printed. Each staggered horizontal and straight vertical line should be complete, with no gaps in the dot pattern, as shown below:

- If your printout looks okay, you're done.
- If any dots are missing (as shown below), clean the print head again; see page 84 for instructions.

Replacing an Ink Cartridge

You can check the status of the ink cartridges by looking at the icons on the control panel:

The level of ink shown inside the icons indicates the amount of remaining ink. If an ink cartridge is low, the corresponding ink cartridge icon flashes; the red error light also flashes. This is a good time to make sure you have a new cartridge. If an ink cartridge is empty, the red error light remains on and you see a message on the display telling you that the cartridge needs to be replaced.

Caution: You cannot print if either ink cartridge is empty. Leave the empty cartridge installed in the printer until you have obtained a replacement, otherwise the ink remaining in the print head nozzles may dry out. To ensure good results, use genuine EPSON ink cartridges and do not refill them. Other products may cause damage to your printer not covered by EPSON's warranty.

When an installed cartridge is more than six months old, you may need to replace it if printouts don't look their best. If the quality doesn't improve after cleaning and aligning the print head, you can replace the cartridge even if the error light is off.
Use these EPSON ink cartridges within six months of installing them and before the expiration date on the package:

- Black ink cartridge: T026201
- Color ink cartridge: T027201

When you need new ink cartridges, contact your dealer or call the EPSON Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

**Removing and Installing Ink Cartridges**

Be sure you have a new ink cartridge before you begin. Once you start the ink cartridge replacement procedure, you must complete all the steps in one session.

1. Make sure the printer is turned on and not printing, then open the printer cover.
2. Do one of the following:
   - If the red error light is on (cartridge is empty), press the maintenance button.
   - If the red error light is flashing (cartridge is low), press the maintenance button. You see **Ink Cartridge Replacement** automatically highlighted in the Advanced Settings menu. Press the **Select** button.

   **Note:** If the error light is off, you can still replace an ink cartridge. Enter the Advanced Settings menu, then select Ink Cartridge Replacement. Continue with the steps below.

3. You see a message on the display telling you that ink cartridge replacement will begin. Press **Custom** button 1 to continue. The print head moves to the center.
4. The black cartridge is on the left and the color cartridge is on the right. Open the ink cartridge cover, then lift the cartridge out of the printer and dispose of it carefully.

**Warning:** Keep ink cartridges out of the reach of children and do not drink the ink.

If ink gets on your hands, wash them thoroughly with soap and water. If ink gets in your eyes, flush them thoroughly with water.

5. Unwrap the new ink cartridge. Then remove *only* the yellow tape seal on top.

**Caution:** You must remove the yellow tape from the top of the cartridge or you will permanently damage it.
6. Lower the cartridge into the holder, resting it on top of the hooks as shown.

**Caution:** Don’t place the cartridge under the hooks, or they may break when you close the cover.

7. Close the ink cartridge cover (press down firmly until it snaps shut).

8. If you need to replace the other ink cartridge, repeat steps 4 through 7 before continuing with step 9.

9. Press **Custom** button 1 and close the printer cover.

The printer begins charging the ink delivery system.

10. When you see a message that charging is complete (after about a minute), press **Custom** button 1 to finish.
Aligning the Print Head

If your printouts contain misaligned vertical lines or horizontal banding, you may need to align the print head.

You can align the print head either from the printer's control panel or using your printer software. To align the print head from the printer software, the printer must be connected directly to your computer (not over a network); see your on-screen Reference Guide for details.

**Note:** For the best results, load letter-size EPSON Photo Quality Ink Jet Paper in the printer whenever you check the print head alignment.

Follow these steps to align the print head using the control panel:

1. Make sure the printer is turned on but not printing, and letter-size paper is loaded.
2. Use the button to highlight Advanced Settings, then press the Select button.
3. Press the or button until Print Head Alignment is highlighted, then press the Select button.
4. Press Custom button 1 to print the alignment pattern.
5. Once the pattern is done printing, examine the first row or set of lines (marked #1). Select the line (1-15) in which all the vertical dots are best aligned. You may need to use a magnifying glass.
6. Use the and buttons to display the number of that line (1-15), then press the Select button.
7. Repeat the selection of the best line for set #2, and then for set #3.
8. When you're finished, press Custom button 1.
Aligning the Cutter

If you’re using the cutter to automatically cut photos printed on 4” roll paper, you may notice that the cuts are not aligned exactly with the edges of your photos. In this case, you can use the Cutting Position Adjustment to align your cuts more precisely.

1. Make sure the printer is turned on but not printing, and letter-size paper is loaded.
2. Use the button to highlight Advanced Settings, then press the Select button.
3. Continue pressing the button until Cutting Position Adjustment is highlighted, then press the Select button.
4. Press Custom button 1 to print and automatically cut the adjustment pattern.
5. Once the pattern is done printing, place the cut pieces together and determine which section (1-17) is cut most exactly on the border between the two colors. (In the example above, number 9 shows the best cut.)
6. Use the and buttons to display the number of that section (1-17), then press the Select button.
Cleaning the Printer

To keep your printer working at its best, you should clean it several times a year. Follow these steps:

1. Turn off the printer, unplug the power cord, and disconnect the printer cable.
2. Remove all paper, then use a soft brush to clean any dust or dirt from the sheet feeder.
3. Clean the exterior of the printer with a soft, damp cloth.
4. Use a soft, dry cloth to clean the display and optional preview monitor. Do not use liquid or chemical cleaners on these parts.
5. If ink has spilled inside the printer, wipe it off with a soft, damp cloth.

Caution: Be careful not to wipe away lubricating grease inside the printer.

Don’t touch the gears inside the printer.

Never use a hard or abrasive brush, or alcohol or thinner for cleaning; they can damage the printer components and case.

Don’t get water on the printer components and don’t spray lubricants or oils inside the printer.

Don’t use any cleaning sheets included with special paper; they may jam inside the printer.
Transporting the Printer

If you move your printer some distance, you need to prepare it for transportation in its original box or one of a similar size.

**Caution:** To avoid damage, always leave the ink cartridges installed when transporting the printer.

Follow these steps:

1. Turn on the printer, wait until the print head locks in the far right position, then turn off the printer.
2. Unplug the power cord from the electrical outlet. Then disconnect the printer cable from the printer.
3. Remove any paper from the printer and remove the paper support.
4. Open the printer cover. Secure the ink cartridge holder to the printer with tape as shown, then close the printer cover.
5. Push in the output tray extensions and close the tray.
6. Repack the printer and its attachments in the original box using the protective materials that came with them. See your *Start Here* sheet.

Keep the printer level as you transport it.

After transporting the printer, remove the tape securing the print head and test your printer. If you notice a decline in print quality, clean the print head (see page 84); if output is misaligned, align the print head (see page 89).
Problem Solving

See these sections to diagnose and solve printer problems:

- “Diagnosing Problems” on page 94
- “Solving Problems Setting Up the Printer or Installing Software” on page 94
- “Solving Printer Problems” on page 95
- “Solving Print Quality Problems” on page 97
- “Solving Problems with Paper Feeding” on page 100
- “Solving Miscellaneous Printout Problems” on page 101
- “Running a Printer Check” on page 103
- “Uninstalling and Reinstalling Printer Software” on page 104
- “Where To Get Help” on page 106
Diagnosing Problems

Your EPSON Stylus Photo 925 includes a number of ways to help you diagnose problems:

- To identify the most common problems, check for messages on the control panel display and follow the instructions provided.
- If you’re not sure whether the problem is coming from your printer or the computer, run a printer check as described on page 103.
- Check for solutions in the following sections of this chapter. If none of the suggested solutions solve your problem, contact EPSON as described on page 106.

Solving Problems Setting Up the Printer or Installing Software

The printer makes noise after ink cartridge installation.

- The first time you install ink cartridges, the printer must charge its print head for about two minutes. Wait until charging finishes before you turn off the printer, or it may charge improperly and use excess ink the next time you turn it on.
- Make sure the ink cartridge clamps are locked down completely and no packing material remains in the printer. Turn off the printer, wait a moment, then turn it back on to clear the error.

You’re having problems installing the printer software.

- Make sure your printer is turned on and the printer cable is securely connected at both ends. Then carefully follow the installation instructions on the Start Here sheet. Also make sure your system meets the requirements shown on page 117.
- Close your other programs, including any screen savers and virus protection software, and install again.
- If your printer icon (SP 925) doesn’t appear in the Macintosh Chooser, you may have too many items in the Chooser. Delete any unused items and check the Chooser again.
- If you are using OS X and you do not see all the available paper types and printer features when you open the Format for menu in the Page Setup window, you may not have installed the printer software correctly. See the Start Here sheet for instructions.
■ For Windows 2000, if you see an error message or your software doesn’t install correctly, you may not have software installation privileges. Contact your System Administrator.

■ Make sure Windows 98, Me, 2000, or XP was preinstalled on your system. The USB Printer Device Driver may not install correctly if you've upgraded from Windows 95.

■ Make sure the USB Controller is working properly in Device Manager. See your Windows help system for details. If it’s not working, contact your computer manufacturer.

■ If you're printing over a network, see your on-screen Reference Guide for instructions on configuring your printer for use on a network.

---

Solving Printer Problems

The printer is on, but nothing prints.

■ If you're printing from your computer, make sure the USB cable is connected securely and that the cable meets the system requirements on page 117.

■ If you're printing from your computer, run a printer check as described on page 103. If the check page prints, make sure your software is installed correctly.

■ If you're printing on a network, you need to set up your printer for network printing, as described in your on-screen Reference Guide.

The printer sounds as though it is printing, but nothing prints.

■ Make sure the print head nozzles are not clogged. To clean the print head, see page 84.

■ The printer won’t operate properly if it’s tilted or at an angle. Place it on a flat, stable surface that extends beyond the printer base in all directions.

Your printer makes noise when you turn it on or after it has been sitting for awhile.

Your printer is performing routine maintenance.

The optional preview monitor and control panel respond too slowly.

When you have lots of photos or large files on your memory card, it takes longer for the preview monitor to process them. This causes the monitor and control panel to respond more slowly. Try deleting any photos you don't need before you remove the card from your camera.
Printing is too slow.

Make sure your system meets the requirements listed on page 117. If you're printing a high-resolution image, you need more than the minimum requirements listed. You may also need to:

■ Clear space on your hard drive or run a defragmentation utility.
■ Close open programs that you're not using.
■ Increase your system's memory (RAM).

For the fastest printing, try these tips:

■ Choose Black ink if your document doesn't include color.
■ Set the Quality/Speed slider to Speed.
■ In the Advanced window, turn MicroWeave® off and/or turn High Speed on.
■ If your printer is connected to a hub, disconnect USB devices that you're not using.

**Note:** Borderless printing takes longer than normal, especially near the edges of the paper. Printing without a computer is also a bit slower.

Your memory card does not work correctly.

■ If you're using different kinds of memory cards, make sure only one card is inserted at a time.
■ Make sure the card contains no more than 999 photos (or the last photos won't display), and that the photos are in JPEG format and taken with a DCF-compliant digital camera.
■ Make sure you follow the instructions on the Start Here sheet to install PhotoStarter and CardMonitor. If you use the New Hardware Wizard, these utilities may not be installed.
■ Check your PhotoStarter settings. See page 47 for instructions.
■ If you access the card from your computer and delete files, the card may not work correctly with your camera. Always delete pictures using your camera.
■ If you're using Windows XP, you may need to install your Windows storage device driver.
Solving Print Quality Problems

You see banding (light lines).

- The print head nozzles may need cleaning; see page 84 for instructions.
- Select a higher print quality and turn off High Speed mode. See page 50 (Windows) or page 55 (Macintosh).
- If you’re printing without a computer, make sure the printer’s Paper Type setting matches the type of paper you’re using; see page 29 for guidelines.
- If you’re printing from a computer, make sure the Media Type setting matches the paper you loaded; see page 72 for guidelines.
- Make sure the printable side of the paper is face up. It’s usually whiter or shinier.
- The ink cartridges may need replacing. To replace an ink cartridge, see page 85.
- Try using Automatic mode. See page 50 (Windows), page 55 (Macintosh OS 8.6 to 9.x), or page 56 (Macintosh OS X) for instructions.
- Run the Print Head Alignment utility; see page 89 for instructions.
- If you’re printing on envelopes or thicker paper, set the paper thickness lever to the \( \uparrow \) position for envelopes, as shown. Remember to return the lever to the \( \downarrow \) position when printing on individual sheets or roll paper. You may also need to turn off High Speed (in the Advanced window).
Your printout is blurry or smeared.
- Use EPSON papers to ensure proper saturation and absorption of genuine EPSON inks.
- Make sure you load paper with the printable side face-up. The printable side is usually the whiter or brighter side of the paper.
- Make sure your paper isn't damp or curled, or loaded face down (the printable side should be face up). If it's damp or curled, reload a new stack of paper.
- When printing on special paper, check the instructions in the paper package. You may need to use an included support sheet or load your paper one sheet at a time.
- Make sure your paper meets the specifications listed in the on-screen Reference Guide.
- Run the Print Head Alignment utility. See page 89 for instructions.
- Check the position of the paper thickness lever. For most papers, set the paper thickness lever forward. If you're printing on thick paper or envelopes, you may need to move the lever to the position for envelopes.
- Remove each sheet from the output tray after printing, especially when you're printing on transparencies.

Your printout is faint or has gaps in the image.
- The print head nozzles may need cleaning; see page 84 for instructions.
- The ink cartridges may be old or low on ink. To replace an ink cartridge, see page 85.
- If you're printing without a computer, make sure the printer's Paper Type setting matches the type of paper you're using; see page 29 for guidelines.
- If you're printing from a computer, make sure the Media Type setting matches the paper you loaded; see page 72 for guidelines.
- Make sure your paper isn't damaged, old, dirty, or loaded face down. If it is, reload a new stack of paper with the printable side up; it is usually whiter or shinier than the other side.
You see wrong or missing colors.

- Make sure the Ink setting is set to Color for color images or black-and-white prints and your software is set for color printing.
- The print head nozzles may need cleaning; see page 84 for instructions.
- The ink cartridges may be old or low on ink. To replace an ink cartridge, see page 85.
- Try turning off PhotoEnhance. Also check if you're using a special effect that alters image colors, like Sepia.
- Try using Automatic mode. See page 50 (Windows), page 55 (Macintosh OS 8.6 to 9.x), or page 56 (Macintosh OS X) for instructions.
- Try changing the Gamma setting in the Advanced window; see page 69 for information about accessing Advanced settings.
- Your printed colors can never exactly match your on-screen colors. However, you can use a color management system to get as close as possible. You can also use your printer's color management features. See page 68 (Windows) or page 70 (Macintosh).

Your printout is grainy.

- Try using a higher quality paper.
- Select a higher print quality setting. If you're printing without a computer, see page 28. If you're printing from your computer, see page 69.
- Run the Print Head Alignment utility. See page 89 for instructions.
- You may need to increase the image resolution or print it in a smaller size; see your software documentation.
Solving Problems with Paper Feeding

Paper doesn't eject fully or is wrinkled.
- If the paper doesn't eject fully, you may have set the wrong paper size. Press the \( \text{maintenance button} \) to eject the paper, and then select the correct paper size.
- If it's wrinkled when it ejects, the paper may be damp or too thin.

Paper doesn't feed correctly or jams in the printer.
- Make sure the paper support is attached.
- If paper doesn't feed, remove it from the sheet feeder, reload it against the right edge, then slide the left edge guide against the paper.
- If multiple pages feed at once, remove the paper from the sheet feeder, fan the edges to separate the sheets, and carefully reload it.
- If paper jams, press the \( \text{maintenance button} \) for several seconds to clear the jam. If that doesn't work, open the cover and remove any jammed paper, including small pieces that may have torn off. Reload the paper and press the \( \text{maintenance button} \).

If your paper loads incorrectly or jams frequently:
- Use new, smooth, high-quality paper, loaded printable side up. Don't load paper above the arrow mark on the left edge guide.
- Place the paper against the right edge and slide the left edge guide against it, but not too tight.
- Store paper flat to prevent curling.

Roll paper doesn't feed correctly.
- To load paper correctly, gently hold the paper in place with your hand while pressing the \( \text{button} \). Don't force the paper to feed into the printer. Allow the paper to feed automatically.
- If the paper is curled, roll it inside a folded sheet of paper in the direction opposite to the paper's curl. You don't need to uncurl the entire roll—only about 3 inches.
- If you're printing from a computer, be sure to select the correct the roll paper option as the Paper Source (Windows and Mac OS 8.6 to 9.x). If Sheet Feeder is selected, paper may feed unnecessarily after each print job. In Mac OS X, choose the correct roll paper option in the Format for menu on the Page Setup window. Then choose Print from the File menu and select the same roll paper option in the Printer pull-down menu.
Use a triangle or other tool to make sure the end of the roll is cut perpendicular to the edges. If the end is cut on a diagonal, the paper may not feed smoothly.

If you see a paper jam error message, follow the instructions on the printer display to clear the error.

If the red error light is on, press the roll paper button for 3 seconds, then pull the paper fully out of the printer. Then press the roll paper button to clear the error and resume printing.

If roll paper has jammed, follow these steps:
1. Cut off any completed printouts, if necessary.
2. Press the roll paper button and hold it down for 3 seconds. The paper feeds all the way back.
3. Turn the knobs on the roll paper holders to rewind the paper so none remains in the feed slot.
4. Press the maintenance button to clear the error message.
5. Make sure the paper is cut straight across and is not curled, then reload it.

If you’re using the cutter and your photos don’t stack neatly when they come out of the printer, try extending the output tray.

If extra paper feeds after a print job or after you turn on the printer, press the roll paper button for three seconds to rewind the paper. (You may need to repeat this.) If necessary, turn off the printer and gently pull the paper out backward by hand.

---

Solving Miscellaneous Printout Problems

The image is inverted.

Turn off the Flip Horizontal setting in the Advanced window or the mirror setting in your program. (If you’re printing on EPSON Iron-On Transfer Paper, the image should be inverted.)

The printer prints blank pages.

- Make sure your printer is selected, or is the active printer in the Print Center or Macintosh Chooser.
- The print head nozzles may need cleaning. See page 84.
The margins are incorrect.

■ Make sure the paper settings are correct for your paper size.
■ Make sure the paper is positioned correctly in the feeder, all the way to the right. Slide the left edge guide against the paper.
■ See your software documentation for instructions on choosing the correct margins for your paper size. The margins must be within the printable area of the page. See “Printer Specifications” in your on-screen Reference Guide.

Image size or position is incorrect.

■ Make sure paper and layout options are set correctly.
■ Your images may not match the width/height proportions (aspect ratio) of the paper size or layout you’re using. Images may be cropped to fit the paper and layout.

You see incorrect characters.

■ Make sure the USB cable is securely connected and meets the system requirements on page 117. Then try printing again.
■ Make sure your printer is selected in your software, or is set as the active printer in the Print Center or Macintosh Chooser.
■ If you’re using a USB hub, connect the printer directly to your computer instead.

The wrong photo is printed.

The photo numbering in the printer may not match the numbering in your camera. If you’re printing without a computer, first print an index to identify your photos by number.

Too many copies are printing.

Make sure that the Copies option in your printer software or program is not set for multiple copies.
Running a Printer Check

You may need to run a printer check to see if a problem comes from the printer itself or some other source.

1. Make sure both the printer and computer are turned off. Then disconnect the USB cable from the printer.
2. Make sure letter-size or larger paper is loaded in the printer.
3. Hold down the \( \odot \) roll paper button, then press and release the \( \bigcirc \) power button.

4. The printer prints a page showing its ROM version number and a nozzle check pattern. (If the pattern has gaps, you need to clean the print head; see page 84.)
   - If the check page printed, the problem probably lies in your memory card, software settings, the interface cable, or your computer, or your software may not be installed correctly.
   - If the check page did not print, you may have a problem with your printer. Try the suggestions in “Solving Problems Setting Up the Printer or Installing Software” beginning on page 94. If nothing works, contact your dealer or EPSON as described on page 106.
5. After examining the check page, remember to turn off the printer and reconnect its cable to your computer.
Uninstalling and Reinstalling Printer Software

You may need to uninstall and then reinstall your printer driver and utilities. For example, this might be necessary when you upgrade your Windows operating system. You don't need to uninstall Film Factory, PhotoImpression, the P.I.M. II Plug-in, or your on-screen Reference Guide.

**Note:** Do not turn off or disconnect the printer while you are uninstalling the software.

**Windows**

1. Double-click My Computer (Windows XP: click Start instead), then double-click the Control Panel icon.
2. Double-click Add/Remove Programs.
3. Click EPSON Printer Software in the program list and click the Add/Remove button (Change/Remove button on Windows 2000 and XP).
4. In the next window, make sure your EPSON Stylus Photo 925 printer icon is selected and click OK. Then follow the on-screen instructions.
5. In Windows 98 or Me, click EPSON USB Printer Devices in the program list and click the Add/Remove button.
   If you are using Windows XP or 2000, go to step 9.
6. When you see the prompt asking if you want to reboot, click No.
7. Click EPSON PhotoStarter3.0 in the program list and click the Add/Remove button. Then follow the on-screen instructions.
8. Click EPSON CardMonitor in the program list and click the Add/Remove button. Then follow the on-screen instructions.
9. Restart your computer when you're done.

When you are ready to reinstall the printer software, follow the correct instructions for your operating system:

- For Windows Me, follow the instructions on page 110.
- For Windows 2000, follow the instructions on page 113.
- For Windows XP or 98, see the instructions on your printer's Start Here sheet.

**Note:** Remember that you don’t need to reinstall your optional photo software or on-screen Reference Guide, and you won’t see the license agreement.
**Macintosh OS 8.6 to 9x**

1. Close all applications.
2. Insert the printer software CD-ROM.
3. In the EPSON window, scroll down and double-click the Drivers folder.
4. Double-click the Printer Driver folder. Then double-click the Disk 1 folder.
5. Double-click the Installer icon and click Continue.
6. In the Installer dialog box, select Uninstall from the pull-down menu and click the Uninstall button. Follow the on-screen instructions and click Quit when you're done.
7. In the Drivers folder, double-click the EPSON PhotoStarter 3.0 Installer folder, then double-click the Installer icon. When you see the license agreement, click Accept.
8. Select Uninstall from the pull-down menu and click the Uninstall button. Follow the on-screen instructions and click Quit when you're done.
9. In the Drivers folder, double-click the EPSON CardMonitor 1.0 Installer folder, then double-click the Installer icon. When you see the license agreement, click Accept.
10. Select Uninstall from the pull-down menu and click the Uninstall button. Follow the on-screen instructions and click Quit when you're done.
11. In the Drivers folder, double-click the Memory Card Driver folder, then double-click the Installer icon.
12. Select Uninstall from the pull-down menu and click the Uninstall button. Follow the on-screen instructions and click Quit when you're done.
13. Restart your Macintosh.

**Macintosh OS X 10.x**

You don't need to uninstall the printer driver or the memory card driver. Follow these steps to uninstall EPSON PhotoStarter and Card Monitor:

1. Close all applications.
2. Insert the printer software CD-ROM.
3. Double-click the EPSON CD-ROM icon.
4. Scroll down and double-click the Drivers folder.
5. Double-click the EPSON PhotoStarter 3.0 Installer folder, then double-click the Installer icon. Your Macintosh launches the Classic Environment.
6. When you see the license agreement, click Accept.
7. In the Installer dialog box, select Uninstall from the pull-down menu and click the Uninstall button. Follow the on-screen instructions and click Quit when you're done.

8. In the Drivers folder, double-click the EPSON CardMonitor 1.0 Installer folder, then double-click the Installer icon.

9. When you see the license agreement, click Accept.

10. In the Installer dialog box, select Uninstall from the pull-down menu and click the Uninstall button. Follow the on-screen instructions and click Quit when you're done.

11. Restart your Macintosh.

Where To Get Help

If you need help with your printer, Film Factory, or the P.I.M. II Plug-in for Adobe Photoshop, see the information below. See page 107 for help with ArcSoft PhotoImpression. If you need help using other software with your printer, see the documentation that came with that software.

EPSON provides technical assistance 24 hours a day through the electronic support services and automated telephone services listed below:

<table>
<thead>
<tr>
<th>Service</th>
<th>Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>World Wide Web</td>
<td>From the Internet, you can reach EPSON Support at <a href="http://support.epson.com">http://support.epson.com</a>. At this site, you can download drivers and other files, look at product documentation, access troubleshooting information, and receive technical advice through e-mail.</td>
</tr>
<tr>
<td>Automated Telephone Services</td>
<td>A variety of automated help services are available 24 hours a day, seven days a week. To use these services, you must have a touch tone telephone and call [800] 922-8911. Your EPSON SoundAdvice™ code is <a href="http://support.epson.com">70410</a>. Use this code to quickly select the EPSON Stylus Photo 925 in SoundAdvice.</td>
</tr>
</tbody>
</table>

To speak to a technical support representative, dial:

- U.S.: [562] 276-7282, 6 AM to 8 PM, Pacific Time, Monday through Friday and 7 AM to 4 PM, Saturday.
- Canada: [905] 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Toll or long distance charges may apply.
Before you call, please have the following information ready:

- Product name (EPSON Stylus Photo 925)
- Product serial number (located on the back of the printer)
- Proof of purchase (such as a store receipt) and date of purchase
- Computer configuration
- Description of the problem

You can purchase ink cartridges, paper, manuals, and accessories from the EPSON Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

If you need help with ArcSoft PhotoImpression, use this information:

- Web site: www.arcsoft.com/techmain.htm
- E-mail: support@arcsoft.com
- Telephone: (510) 440-9901, 8:30 AM to 5:30 PM, Pacific Time, Monday through Friday
Installing Your Printer Software

Before installing your printer software, follow the steps on the Start Here sheet to set up your printer and connect it to your computer.

If you're using Windows XP, Windows 98, or a Macintosh, follow the software installation instructions on the Start Here sheet.

If you’re using one of the operating systems below, follow the instructions in this chapter to install your printer software:

- “Installing Printer Software on Windows Me” page 110.
Installing Printer Software on Windows Me

Before you start, make sure your printer is set up, connected to your computer, and turned on, as described on the Start Here sheet. Follow the instructions in the two sections below, first to install your printer driver and utilities, and then to install additional software.

Installing the Printer Driver and Utilities for Windows Me

1. Turn on your computer.

2. Wait for Windows to detect your printer connection and display a screen like this.

   Don’t click any buttons on the screen yet.

   ![Add New Hardware Wizard]

   **Note:** If this screen doesn’t appear, make sure your printer is turned on and connected.

3. Put the EPSON CD-ROM in your CD-ROM or DVD drive and wait a few seconds for the CD-ROM to be recognized.

   ![Insert CD]

   Your software is installed automatically and various messages appear on the screen.

4. Click Finish or Next on the next series of screens until setup is complete.
5. When you see this message about installing additional software click OK:

6. When you see the license agreement, read it and click Agree, then continue with the instructions in the next section to finish the installation.

**Installing Additional Software for Windows Me**

After you accept the license agreement, you see this software installation screen:

1. Click Continue. Additional software is installed; follow the on-screen instructions.
2. When you see the EPSON PhotoStarter Setup screen, click Next and follow the on-screen instructions.
3. When you see the EPSON CardMonitor Setup screen, click Next and follow the on-screen instructions.
4. When setup is complete, select Yes to restart your computer and click Finish.

Leave in the CD-ROM as your computer restarts. You see the Optional Software menu:

5. Click the button for each program to learn more about it. If you want the program, click Install and follow the instructions on the screen.

6. If you see a message about installing QuickTime®, click Yes and follow the on-screen instructions. You don't need a registration number.

7. When you're finished installing software, and click Exit.

8. When you see the registration screen, register your printer with EPSON as instructed. Remove the CD-ROM and keep it in case you need to reinstall any software later.

You're ready to print.
Installing Printer Software on Windows 2000

Before you start, make sure your printer is set up, connected to your computer, and turned on, as described on the Start Here sheet. Follow the instructions in the two sections below, first to install your printer driver and utilities, and then to install additional software.

Installing the Printer Driver and Utilities for Windows 2000

1. Turn on your computer.

2. Wait for Windows to detect your printer connection and display a screen like this:
   
   Don't click any buttons on the screen yet.

   ![Found New Hardware Wizard](image)

   Note: If this screen doesn’t appear, make sure your printer is turned on and connected.

3. Put the EPSON CD-ROM in your CD-ROM or DVD drive and wait a few seconds for the CD-ROM to be recognized.

4. Click Next.
5. Click the **Search for** option, then click **Next**.

6. Select **CD-ROM drives** only, then click **Next**.

7. At the next screen, click **Next**. The installation proceeds automatically.

8. When the installation is complete, click **Finish**.

9. You see another New Hardware Wizard screen. Continue clicking **Next** or **Finish** to install all the software. The installation proceeds automatically.
10. If you see this screen, click Yes to continue. Otherwise the installation will not be complete.

11. When you see a message about installing additional software, click OK.

12. When you see the license agreement, read it and click Agree, then continue with the instructions in the next section to finish the installation.

**Installing Additional Software for Windows 2000**

After you accept the license agreement, you see this software installation screen:

1. Click Continue. Additional software is installed; follow the on-screen instructions.
2. When you see the EPSON PhotoStarter Setup screen, click Next and follow the on-screen instructions.
3. When you see the EPSON CardMonitor Setup screen, click Next and follow the on-screen instructions.
4. When setup is complete, select **Yes** to restart your computer and click **Finish**.

![Maintenance Complete](image1)

Leave in the CD-ROM as your computer restarts. You see the Optional Software menu:

![Optional Software](image2)

**Note:** If you don’t see this screen, click the EPSON CD-ROM icon, then click the EPSON icon.

5. Click the button for each program to learn more about it. If you want the program, click **Install** and follow the instructions on the screen.

6. If you see a message about installing QuickTime, click **Yes** and follow the on-screen instructions. You don’t need a registration number.

7. When you’re finished installing software, click **Exit**.

8. When you see the registration screen, register your printer with EPSON as instructed. Remove the CD-ROM and keep it in case you need to reinstall any software later.

You’re ready to print.

---

**116 Installing Your Printer Software**
Notices

Windows System Requirements

- A Microsoft Windows compatible PC with a Pentium® or better processor, 233 MHz or faster processor
- Windows 98, Windows 2000, Windows Me, or Windows XP
- 64MB of RAM (128MB or more recommended)
- 200MB or more available hard disk space recommended
- VGA or better display adapter and monitor
- CD-ROM or DVD drive for installing the printer software
- Windows-compliant USB port and a shielded USB “AB” cable up to 6.5 feet (2 meters) long.

   **Caution:** Using an improperly shielded USB cable—especially a cable more than 6.5 feet (2 meters) long—may cause the printer to malfunction.

Macintosh System Requirements

- An Apple® iMac™ series, Power Macintosh® G3 or G4, PowerBook®, iBook™, or eMac™
- Mac® OS 8.6 through 9.x, or OS X 10.1 through 10.2.4
- 64MB of available RAM (128MB for OS X); more recommended
- 200MB or more available hard disk space recommended
- VGA display or better
- CD-ROM or DVD drive for installing the printer software
- Built-in USB port and a shielded USB “AB” cable up to 6.5 feet (2 meters) long.

   **Caution:** Using an improperly shielded USB cable—especially a cable more than 6.5 feet (2 meters) long—may cause the printer to malfunction.
Important Safety Instructions

Before using your printer, read the following safety instructions to make sure you use the printer safely and effectively:

■ Be sure to follow all warnings and instructions marked on the printer.
■ Use only the type of power source indicated on the printer’s label.
■ Connect all equipment to properly grounded power outlets. Avoid using outlets on the same circuit as photocopiers or air control systems that regularly switch on and off.
■ Place the printer near a wall outlet where the plug can be easily unplugged.

Placed l'imprimante près d'une prise de contacte où la fiche peut être débranchée facilement.
■ Do not let the power cord become damaged or frayed.
■ If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged into the extension cord does not exceed the cord’s ampere rating. Also, make sure the total ampere rating of all devices plugged into the wall outlet does not exceed the wall outlet’s ampere rating.
■ Keep your printer and computer system away from potential sources of electromagnetic interference, such as loudspeakers or cordless telephone base units.
■ Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
■ Leave enough room around the printer for sufficient ventilation.
■ Do not place the printer near a radiator or heating vent or in direct sunlight.
■ Place the printer on a flat, stable surface that extends beyond the printer base in all directions. The printer will not operate properly if it is tilted or at an angle.
■ Turn off and unplug the printer before cleaning. Clean with a damp cloth only. Do not spill liquid on the printer.
■ Use a soft, dry cloth only to clean the display and optional preview monitor. Do not use liquid or chemical cleaners on these parts.
■ Always leave the cover on the preview monitor slot, unless you are using the optional preview monitor.
■ Always turn the printer off using the power button. It may take a moment for the printer to shut off after you press the button. Don't switch off the power strip or unplug the printer until the printer is off.
■ Do not block or cover the openings in the printer’s case or insert objects through the slots.
■ Except as specifically explained in this manual, do not attempt to service the printer yourself.
■ Do not remove a memory card or turn off the printer while the computer and card are communicating (when the light next to the card is flashing). Doing so can corrupt files on the memory card.
If the liquid crystal solution from the display or the optional preview monitor gets on your hands, wash them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them immediately with water. If discomfort or vision problems remain after a thorough flushing, see a physician immediately.

Unplug the printer and refer servicing to qualified service personnel under the following conditions:

If the power cord or plug is damaged; if liquid has entered the printer; if the printer has been dropped or the case damaged; if the display or optional preview monitor are damaged; if the printer does not operate normally or exhibits a distinct change in performance. Adjust only those controls that are covered by the operating instructions.

**Ink Cartridge Safety Instructions**

- Keep ink cartridges out of the reach of children and do not drink the ink.
- Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them immediately with water.
- Do not put your hand inside the printer or touch the cartridge during printing.
- Do not move the print head by hand. You may damage the printer.
- Install the ink cartridge immediately after you remove it from its foil package. Leaving the cartridge unpacked for a long time before use can result in reduced print quality.
- Do not use an ink cartridge beyond the date printed on the cartridge carton. For best results, use up the ink cartridges within six months of first installing them.
- Store ink cartridges in a cool, dark place.
- After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature for at least three hours before using it.
- Do not shake an ink cartridge; this can cause leakage.
- Do not dismantle the ink cartridges or try to refill them. This could damage the print head.
- Do not touch the green IC chip on the side of the cartridge. This may affect normal operation and printing.
- If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in the same environment as the printer. Note that there is a valve in the ink supply port, making covers or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge touches. Do not touch the ink cartridge ink supply port or surrounding area.
- Before transporting the printer, make sure the print head is capped in the far right position and the ink cartridges are in place. Tape the ink cartridge holder to the printer case to make sure it remains in the proper position.
ENERGY STAR Compliance

As an ENERGY STAR Partner, EPSON has determined that this product meets the ENERGY STAR guidelines for energy efficiency. The EPA ENERGY STAR office equipment program is a voluntary partnership with the computer and office equipment industry to promote the introduction of energy-efficient personal computers, monitors, printers, fax machines, and copiers in an effort to reduce air pollution caused by power generation.

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio or television reception. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause interference to radio and television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.
■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
■ Consult the dealer or an experienced radio/TV technician for help.

WARNING: The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC Certification of this device and may cause interference levels which exceed the limits established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded equipment interface cable with this device. If this equipment has more than one interface connector, do not leave cables connected to unused interfaces. Changes or modifications not expressly approved by the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
Declaration of Conformity

According to 47CFR, Part 2 and 15 for Class B Personal Computers and Peripherals; and/or CPU Boards and Power Supplies used with Class B Personal Computers:

We: EPSON AMERICA, INC.
Located at: MS: 3-13
3840 Kilroy Airport Way
Long Beach, CA 90806-2469
Telephone: (562) 290-5254

Declare under sole responsibility that the product identified herein, complies with 47CFR Part 2 and 15 of the FCC rules as a Class B digital device. Each product marketed is identical to the representative unit tested and found to be compliant with the standards. Records maintained continue to reflect the equipment being produced can be expected to be within the variation accepted, due to quantity production and testing on a statistical basis as required by 47CFR §2.909. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

Trade Name: EPSON
Type of Product: Ink Jet Printer
Model: B151A
Epson America, Inc., Limited Warranty

What Is Covered: Epson America, Inc. ("Epson") warrants to the first retail purchaser that the EPSON printer covered by this limited warranty statement, if purchased and used in the United States or Canada, conforms to the manufacturer's specifications and will be free from defects in workmanship and materials for a period of one (1) year from the date of original purchase. Epson also warrants that the consumable ink cartridges enclosed with the printer will perform to the manufacturer's specified usage, which usage may expire before the expiration of the limited warranty for the EPSON printer. For warranty service, you must provide proof of the date of original purchase.

What Epson Will Do To Correct Problems: Should your EPSON printer prove defective during the warranty period, please call the EPSON Connection* at (562) 276-7282 (U.S.) or (905) 709-2567 (Canada) for warranty repair instructions and return authorization. An Epson service technician will provide telephone diagnostic service to determine whether the printer requires service. If service is needed, Epson will, at its option, exchange or repair the printer without charge for parts or labor. If Epson authorizes an exchange for the defective unit, Epson will ship a replacement printer to you, freight prepaid, so long as you use an address in Canada or the U.S. (excluding Puerto Rico and U.S. Possessions). Shipments to other locations will be made freight collect. You are responsible for securely packaging the defective unit and returning it to Epson within five (5) working days of receipt of the replacement. Epson requires a debit or a credit card number to secure the cost of the replacement printer in the event that you fail to return the defective one. If your printer is being repaired, Epson will direct you to send your printer to Epson or its authorized service center, where the printer will be fixed and sent back to you. You are responsible for packing the printer and for all costs to and from the Epson authorized service center. When warranty service involves the exchange of the printer or a part, the item replaced becomes Epson property. The replacement printer or part may be new or refurbished to the Epson standard of quality, and, at Epson's option, may be another model of like kind and quality. Epson's liability for replacement of the covered printer will not exceed the original retail selling price of the covered printer. Exchange products and parts assume the remaining warranty period of your original product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal use in the United States and Canada. This warranty is not transferable and will not apply to products purchased from an end user. This warranty does not cover any color change or fading of prints or reimbursement of materials or services required for reprinting. This warranty does not cover damage to the EPSON product caused by parts or supplies not manufactured, distributed or certified by Epson. This warranty does not cover ribbons, ink cartridges or third party parts, components, or peripheral devices added to the EPSON product after its shipment from Epson, e.g., dealer or user-added boards or components. Epson is not responsible for warranty service should the Epson label or logo or the rating label or serial number be removed or should the product fail to be properly maintained or fail to function properly as a result of misuse, abuse, improper installation, neglect, improper shipping, damage caused by disasters such as fire, flood, and lightning, improper electrical current, software problems, interaction with non-Epson products, or service other than by an Epson Authorized Servicer. If a claimed defect cannot be identified or reproduced, you will be held responsible for the costs incurred.
THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE. SOME LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. UNLESS STATED HEREIN, ANY STATEMENT OR REPRESENTATIONS MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts, and some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above limitations and exclusions may not apply to you. This warranty gives you specific legal rights and you may have other rights which vary from jurisdiction to jurisdiction.

Epson America, Inc., P.O. Box 93012, Long Beach, CA 90809-3012
Index

A
Accessories, 107
Adobe Photoshop, P.I.M. II plug-in for, 3, 77 to 81
Advanced settings, 69, 71
Aligning print head, 89
ArcSoft PhotoImpression, 3, 45, 73
Automatic mode
  Macintosh, 54 to 58
  Windows, 50

B
Background printing, 55
Banding, 97
Blank pages, 101
Blurry images, 98
BorderFree printing, 60 to 65, 76

C
Cable, printer, 117
Camera, connecting, 21
Cancelling printing
  from control panel, 28
  Macintosh, 55, 59
  Windows, 52
CardMonitor, 46, 47
Characters, incorrect, 102
Checking printer, 103
Cleaning
  print head, 84 to 85
  printer, 91
  sheets, 91
Color Management settings
  Mac OS X, 58
  Macintosh, 70 to 71
  printing without a computer, 33 to 34
  Windows, 68 to 69
Color problems, 99
ColorLife Photo Paper, 9
ColorSync, 58, 70
CompactFlash memory card, 19, 46
Controlling printing
  Macintosh, 55, 59
  Windows, 52
Copying photos to computer, 46 to 48
Crop marks, 37
Cropping, 35 to 36
Custom settings
  Macintosh, 70 to 71
  printing without a computer, 32
  Windows, 68 to 69
Cutter Alignment utility, 90

D
Default settings
  Windows, 53
Digital camera files, 19 to 22
Digital camera, connecting, 21
Documentation, 4 to 6
DPOF (Digital Print Order Format), 18, 23, 26

E
Economy setting, 70
Edge-to-edge printing, 60 to 65
Electronic manual, 5 to 6
Envelopes, loading, 12
EPSON
  accessories, 107
  help, 106 to 107
  papers, 7 to 16, 60, 72
  Store, 10, 86, 107
  EPSON PhotoCenter, 3
Exif Print
   description, 2
   with Film Factory, 73 to 76
External storage device, connecting, 21

F
Faint images, 98
Files, printing without a computer, 19 to 22
Film Factory, 3, 73 to 77
Flip Horizontal setting, 101
Frames, adding to stickers, 39
Full bleed printing, 60 to 65

G
Grainy prints, 99
Greeting cards, printing, 41

H
Head Cleaning utility, 84
Help, EPSON, 106 to 107
High Speed setting, 96 to 97
High-quality (resolution) images, 69

I
ICM (Image Color Matching) setting, 68
Image size, selecting when printing without a computer, 30
Incorrect characters, 102
Incorrect colors, 99
Index, printing without a computer, 23
Ink cartridge
   level of ink in, 52, 55, 85
   ordering, 86
   replacing, 86 to 88
   safety instructions, 87, 119
Ink Jet Transparencies, 72
Ink level, checking
   Macintosh, 55
   Windows, 52
   without computer, 85
Ink setting
   Macintosh, 55
   Windows, 50

Installation problems, 94 to 95
Installing software, 109 to 116
Inverted image, 101
Iron-On Transfer Paper, printing without a computer, 42

J
Jams, paper, 100
JPEG files, printing requirements, 19

L
Layout problems, 102
Layout settings
   Macintosh, 55, 58
   Windows, 51
Lever, thickness, 12, 97, 98

M
Macintosh
   basic printing, 53 to 59
   printing with, 53 to 72
   system requirements, 117
   uninstalling and reinstalling software, 105 to 106
Maintaining printer, 83 to 91
Marginless printing, 60 to 65
Margins, incorrect, 102
Matte Paper - Heavyweight, 9
Media Type setting
   list of settings, 72
   Mac OS 8.6 to 9.x, 54
   Mac OS X, 58
   Macintosh, 55
   Windows, 50
Memory cards
   inserting, 19 to 20, 46
   removing, 20, 48
   saving files, 43
Memory Stick, 19, 46
Microdrive, 19
MicroWeave setting, 96
Mirror images, 101
Monitoring ink level
  Macintosh, 55
  Windows, 52
  without computer, 85
Moving printer, 92
MultiMediaCard, 21

N
  Network printing, 95
  Noise, printer, 95
  Nozzle Check, 84 to 85

O
  Orientation setting, 54, 57

P
  P.I.M., see PRINT Image Matching
  Page Setup
    Macintosh OS 8.6 to 9.x, 54
    Macintosh OS X, 56
  Paper
    EPSON, 7 to 16, 60, 72
    feeding problems, 100 to 101
    loading, 11 to 14
    orientation, 51, 54, 57
    size, 51, 54, 57
    thickness lever, 12, 97, 98
  Paper Type setting, 27, 29
  Photo Stickers, printing, 38 to 40
  PhotoCenter, EPSON, 3
  Photographs, displaying and storing, 16
  PhotoImpression, ArcSoft, 3, 45, 73
  PhotoStarter, 47
  Premium Glossy Photo Paper, 9
  Preview monitor, 1, 23, 35 to 36, 95
  Previewing printout, 55
  Print dialog box, 49, 54
  Print head
    aligning, 89
    cleaning, 84 to 85
  Print Head Alignment utility, 89
  PRINT Image Matching
    description, 2 to 3
    plug-in for Photoshop, 3, 77 to 81
    printing without computer, 18, 33 to 34
    with ArcSoft PhotoImpression, 73
    with Film Factory, 73 to 77
  Print quality problems, 97 to 99
  Printer
    cable, 117
    check, 103
    cleaning, 91
    maintaining, 83 to 91
    noise, 95
    problems, 93 to 102
    transporting, 92
  Printing
    BorderFree, 76
    controlling, 59
    Macintosh, basic, 53 to 59
    Windows, basic, 49 to 53
    with custom settings, Macintosh, 70 to 71
    with custom settings, Windows, 68 to 69
    with PRINT Image Matching, see PRINT Image Matching
  Printing in Windows
    advanced, 69
    basic settings, 49 to 52
    borderless, 60 to 64
    controlling, 52
    custom settings, 68 to 69
  Printing on a Macintosh
    advanced, 69
    basic settings, 53 to 59
    borderless, 60 to 65
    controlling, 55
    custom settings, 70 to 71
  Printing without a computer
    accessing files, 19 to 22
    cropping, 35 to 36
    custom settings, 32
    greeting cards, 41
    PRINT Image Matching, 18, 33 to 34
    saving files, 43
    selecting photos, 23 to 26
    selecting settings, 27 to 34
Printing, slow, 96
Problems
  installing software, 94 to 95
  memory card, 96
  miscellaneous, 101 to 102
  paper feeding, 100 to 101
  PhotoStarter, 96
  preview monitor, 95
  print quality, 97 to 99
  printer, 93 to 102
Progress Meter, 52

Q
Quality/Speed setting, 50, 55

R
Reference Guide, 5 to 6
Resolution Performance Management (RPM), 1, 69, 71
Roll paper
  cutting options, 15, 64
  feeding problems, 100
  loading, 13 to 14
  printing on, 63 to 67
  removing, 15 to 16, 67
RPM, 1, 69, 71

S
Safety instructions, 118 to 119
Saving files from memory cards, 43
SecureDigital card, 21
Self adhesive sheets, 72
Service, 106 to 107
Slow printing, 96
SmartMedia card, 19, 46
Smears, 98
Software
  installing, 109 to 116
  problems, solving, 94 to 95
  summary, 3
  uninstalling and reinstalling, 104 to 106
sRGB setting, 68

Stickers, printing, 38 to 40
Storing photos, 16
Support, 106 to 107
System requirements, 117

T
Technical support, 106 to 107
Thickness lever, 12, 97, 98
Transferring photos to computer, 46 to 48
Transparencies, 72
Transporting printer, 92
Troubleshooting, 93 to 101

U
Uninstalling and reinstalling software, 104 to 106
USB, 21 to 22, 104, 117
Utilities
  Cutter Alignment, 90
  Head Cleaning, 84
  Nozzle Check, 85
  Print Head Alignment, 89

W
Watermark, 51, 56
Windows
  default settings, 53
  installing software, 110 to 116
  printing with, 49 to 53, 60 to 72
  system requirements, 117
  uninstalling and reinstalling software, 104

Z
Zip drive, connecting, 21 to 22, 43
EPSON Ink Jet Papers and Ink Cartridges

Use EPSON paper and inks to get the same photo quality results that have earned EPSON’s printers all of their awards! EPSON papers are specially coated to work with genuine EPSON inks. Here are details about just a few of EPSON’s papers:

**Premium Glossy Photo Paper**

Water-resistant, photographic-weight paper with a high gloss finish. Perfect for all photographic applications and available in a variety of sizes. Framing is recommended for this paper type.

**Photo Paper and Glossy Photo Paper**

Photo quality, heavyweight glossy paper available in a variety of sizes, including letter, 4 × 6, and panoramic. Perfect for color photo keepsakes of snapshots, reprints, and enlargements.

**Matte Paper Heavyweight**

Heavyweight, bright white, ultra-smooth coated paper with a matte finish. Perfect for photographs, signs, and crafts.

**EPSON Ink Cartridges**

For best results, always use these genuine EPSON ink cartridges:
Black: T026201
Color: T027201

For more information on other EPSON products and fun project ideas, look for the EPSON Print Lab Series at [www.printlabseries.com](http://www.printlabseries.com).

See the inside back cover for a list of EPSON papers and ink cartridges, and ordering information.
How To Order EPSON Ink and Paper

To order EPSON ink cartridges and paper, contact your dealer or call the EPSON Store at (800) 873-7766 or visit www.epsonstore.com (U.S. sales only). In Canada, please call (800) 463-7766 for dealer referral.

EPSON Ink Cartridges
Black: T026201  Color: T027201

EPSON Papers

<table>
<thead>
<tr>
<th>Paper name</th>
<th>Size</th>
<th>Part number</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPSON Premium Bright White Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041586</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041062</td>
</tr>
<tr>
<td></td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041061</td>
</tr>
<tr>
<td></td>
<td>Legal (8.5 x 14 inches)</td>
<td>S041067</td>
</tr>
<tr>
<td>EPSON Photo Quality Ink Jet Cards</td>
<td>A6 (4.1 x 5.8 inches)</td>
<td>S041054</td>
</tr>
<tr>
<td>EPSON Photo Paper</td>
<td>Panoramic (8.3 x 23 inches)</td>
<td>S041146</td>
</tr>
<tr>
<td>EPSON Glossy Photo Paper</td>
<td>Borderless 4 x 6 inches, non-perforated</td>
<td>S041458</td>
</tr>
<tr>
<td></td>
<td>4 x 6 inches, perforated edges</td>
<td>S041134/S041671</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041141/S041649/S041272/S041271</td>
</tr>
<tr>
<td>EPSON ColorLife Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041500</td>
</tr>
<tr>
<td>EPSON Matte Paper Heavyweight</td>
<td>Borderless 8 x 10 inches</td>
<td>S041467</td>
</tr>
<tr>
<td></td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041257</td>
</tr>
<tr>
<td>EPSON Double-Sided Matte Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041568</td>
</tr>
<tr>
<td>EPSON Premium Glossy Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041286/S041667</td>
</tr>
<tr>
<td></td>
<td>Borderless 4 x 6 inches</td>
<td>S041682</td>
</tr>
<tr>
<td></td>
<td>Borderless 5 x 7 inches</td>
<td>S041464</td>
</tr>
<tr>
<td></td>
<td>Borderless 8 x 10 inches</td>
<td>S041465</td>
</tr>
<tr>
<td></td>
<td>Roll (4 inches x 26 feet)</td>
<td>S041302</td>
</tr>
<tr>
<td></td>
<td>Roll (8.3 inches x 32.8 feet)</td>
<td>S041376</td>
</tr>
<tr>
<td>EPSON Premium Semigloss Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041331</td>
</tr>
<tr>
<td></td>
<td>Roll (4 inches x 26 feet)</td>
<td>S041329</td>
</tr>
<tr>
<td>EPSON Premium Luster Photo Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041405</td>
</tr>
<tr>
<td></td>
<td>Roll (8.3 inches x 32.8 feet)</td>
<td>S041408</td>
</tr>
<tr>
<td>EPSON Photo Quality Self Adhesive Sheets</td>
<td>A4 (8.3 x 11.7 inches)</td>
<td>S041106</td>
</tr>
<tr>
<td>EPSON Ink Jet Transparencies</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041064</td>
</tr>
<tr>
<td>EPSON Iron-On Transfer Paper</td>
<td>Letter (8.5 x 11 inches)</td>
<td>S041153/S041155</td>
</tr>
<tr>
<td>EPSON Glossy Photo Greeting Card Kit</td>
<td>Letter (8.5 x 11 inches), perforated edges</td>
<td>S041606</td>
</tr>
<tr>
<td>EPSON Photo Stickers Kit (CD-ROM/paper)</td>
<td>A6 (4.1 x 5.8 inches)</td>
<td>S041144-KIT</td>
</tr>
<tr>
<td>EPSON Photo Stickers (refill)</td>
<td>A6 (4.1 x 5.8 inches)</td>
<td>S041144</td>
</tr>
</tbody>
</table>

The availability of paper types varies by location.